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Warranty

Purchase and/or use of this product signifies your agreement to the terms of this Warranty. MOHR Test and
Measurement LLC (MOHR) warrants that this product will be free from defects in materials and workmanship for a
period of one (1) year from the date of shipment. If any such product proves defective during this warranty period,
MOHR, at its option, either will repair the defective product without charge for parts and labor, or will provide a
replacement in exchange for the defective product.

In order to obtain service under this Warranty, customers must notify MOHR of the defect before the expiration of the
warranty period and make suitable arrangements for the performance of service. Customers shall be responsible for
packaging and shipping the defective product to MOHR with shipping charges prepaid. Customer shall be responsible
for paying all return shipping charges, duties, taxes, and other charges for units returned to any location.

This Warranty is given by MOHR with respect to this product in lieu of any other warranties expressed or implied.
MOHR and its vendors disclaim any implied warranties of merchantability or fitness for a particular purpose. MOHR'’s
responsibility to repair or replace defective units is the sole and exclusive remedy provided to the customer for breach
of the Warranty. MOHR and its vendors will not be liable for any indirect, special, incidental, or consequential
damages irrespective of whether MOHR or the vendor has advance notice of the possibility of such damages.

Specific limitations of this Warranty:

This Warranty only applies to normal and reasonable use of this product. Damage to this product resulting
from improper use, the determination of which is solely at the discretion of MOHR, is specifically excluded
from this Warranty.

Electrical damage to this product resulting from connection of a cable or device carrying a static electrical
charge to the front panel BNC connector or SMA connector without first properly grounding the conducting
elements of the cable or device is specifically excluded from this Warranty.

Electrical damage to this product resulting from connection of a cable or device carrying an electrical signal
or other non-zero electrical potential relative to earth ground to the front panel BNC connector or SMA
connector is specifically excluded from this Warranty.
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Contacting MOHR

Phone

+1-888-852-0408

Mail
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2105 Henderson Loop

Richland, WA 99354

USA
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I General Information

1.1 Product Description

The MOHR CT100/ CT100S / CT100HF Automated Metallic Time-Domain Reflectometers (MTDRS) use a
form of closed-circuit radar known as Time-Domain Reflectometry (TDR) to test cables for defects. These
instruments apply a very fast rise time step signal to the cable under test and then measure the reflected
voltage at very short time intervals. The resultant TDR trace allows the operator to identify changes in
impedance within the cable indicating the presence of faults such as opens, shorts, kinks, defects in the
shield or conductor, foreign substances such as water, or thermal damage. The CT100 and CT100HF can
find extremely subtle cable defects that may be missed by other testing devices.

The CT100 series TDRs have specifications unmatched by any other commercially-available metallic TDR
cable tester. These devices feature timebase resolution of 0.76 ps regardless of cable length, equivalent to
approximately 75 uym in coaxial cable with a Vp of 0.66. This allows for precise cable length measurements
and localization of cable defects. Fast system rise times ensure excellent spatial resolution and make these
instruments particularly valuable for troubleshooting modern high-frequency analog/RF and digital
communications systems.

The CT100 is able to perform continuous sequential sampling at up to 250 kHz, acquiring up to 500 full
500-point TDR traces per second. In concert with the CT100's high-speed internal processor, this allows for
rapid automated cable scans, sophisticated real-time digital filtering techniques (averaging, subtraction,
derivatives, and more), and accurate characterization of transient cable defects.

The CT100 can store thousands of cable scans in its internal non-volatile flash memory. These scans are
easy to call up for comparison so that changes in cable integrity over time can be accurately assessed. To
enter data, use the built-in software keyboard or plug an external barcode reader or keyboard into the front-
panel USB connector. It is easy to connect the CT100 to a host PC using Ethernet or USB to view,
analyze, and store your data.

In the remaining sections, the specific requirements, capabilities, and operation of the CT100, CT100S,
and CT100HF are described in detail. Unless otherwise specified, any reference to the CT100 is also true
of the CT100S and CT100HF.

1.2 Battery Pack and AC Power Requirements

The CT100 may be operated using either the supplied AC adapter or internal NiMH batteries (for a
minimum 6 hours operating time, typical use). The internal NiMH battery charges under AC during normal
operation.

The external AC power adapter is intended to be used with either a 120 VAC or 240 VAC RMS power
source. Use of a standard 3-prong AC socket with intact ground connection is essential for safe operation
of the CT100 with the included AC power adapter. Review the Safety Summary section before operating
the CT100.
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General Information

1.3 Options and Accessories

Options and accessories available for the CT100 are described on page 65.

1.4 Unpacking and Initial Inspection

Before opening the shipping package containing the CT2100, first inspect it for signs of damage. If there is
evidence of damage to the shipping package, notify both the shipping carrier and MOHR.

The shipping container should contain the CT100 and standard accessories, including this Operator's
Manual, front panel cover, external AC adapter and power cord, soft transit case, and calibration fixture(s).
If the shipping container is intact but there are missing items or if the CT100 is damaged, defective, or does
not meet operational requirements, contact a MOHR-authorized sales representative.

1.5 Repacking for Shipment

When the CT100 needs to be shipped to a MOHR-authorized service center for repair, calibration, or other
service, affix a label to the outside of the shipping container indicating the name, address, phone, and
email of the owner, the name of the MOHR service representative who was contacted regarding the
shipment, the serial number of the instrument, and a description of the problem with the instrument and/or
the desired service or maintenance.

Optimally, the original shipping carton and packing material should be used to repack the CT100 for
shipment. Otherwise, the following steps should be taken:

1) Obtain a heavy-duty corrugated cardboard box at least 6 in. (15 cm) larger in each dimension than the
equipment to be shipped to allow for protective cushioning material. The shipping carton should have at
least 200 Ib. (90.7 kg) test strength.

2) Make sure the CT100 is turned off by setting the rear panel power switch to the OFF position.
3) Install the front panel cover.

4) Wrap the CT100 in polyethylene sheeting to protect the case.

5) Place the CT100 in its soft case.

6) Cushion the CT100 on all sides with equal amounts of urethane foam or other firm packing material so
that the instrument is centrally situated in the shipping container and there is no free space for the
CT100 to move about during shipment.

7) Seal the container with packing tape.
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2 Safety Summary

The safety information presented in this brief summary is only intended for operators of the CT100 and
CT100HF. Safety information relating to specific circumstances is present throughout this manual and is
not necessarily present in this summary. Please read this manual in its entirety before using the CT100 and
take note of safety information not included in this summary.

2.1 Terms in the Manual

WARNING: Refers to conditions or practices that could result in personal
injury or loss of life.

CAUTION: Refers to conditions or practices that could result in damage to
this product or other products and in some cases could void the Warranty.

2.2 Terms on the Product

2.2.1 DANGER

Indicates an injury hazard immediately accessible as you read the marking.

2.2.2 WARNING

Indicates an injury hazard not immediately accessible as you read the marking.

2.2.3 CAUTION

Indicates a hazard to property including the product.

2.3 Symbols in the Manual

WARMNING or CALITION
Informaton

CT100/ CT100S / CT100HF Operator's Manual 3



Safety Summary

2.4 Symbols on the Product

AADOD

ATTENTION DANGER Double Insulated Protective Ground
Refer to the High Voltage (Earth) Terminal
Manual

2.5 Static Charge

Any cable or wire can carry a significant static electric charge that could damage the sensitive internal
electronics of the CT100/ CT100S / CT100HF. For this reason, it is essential to discharge the electrical
conductors of any cable or device-under-test (DUT) by shorting them to each other or to earth ground
before connection is made to the CT100’s sampling circuitry.

The CT100 front panel BNC test port is equipped with an internal self-grounding connection that briefly
shorts the conductors of the DUT to each other, dissipating stored charge, before completing the
connection to the CT100’s sensitive internal sampling circuitry. For this reason it is required that the last
cable connection always be made to the CT100 test port. For example, if the DUT is a cable assembly, all
internal connections within the cable assembly should be made before connection is made to the CT100
BNC test port. This ensures that all stored charge in the DUT is discharged during the connection to the
CT100 BNC test port.

Sometimes it is convenient to insert a patch cable between the CT100 BNC test port and the DUT. In this
case, it is recommended that all cable connections, including the connection of the patch cable to the DUT,
be made before connecting the patch cable to the CT100 BNC test port. Otherwise, the BNC test port self-
grounding safety feature is circumvented.

If for some reason the last connection cannot be made at the CT100 test port, then the conductors of the
DUT should be shorted manually using an industry-standard shorting cap termination or equivalent direct
electrical connection.

The CT100S and the CT100HF feature an SMA test port that does not have internal self-grounding
protection. Therefore, when using the CT100S or CT100HF, the conductors of the cable under test / DUT
should always be shorted to each other or to earth ground prior to connection to the CT100HF’s front
panel SMA connector.

CAUTION: Failure to properly ground the cable / device under test prior to
connecting it to the front panel connector, either directly or indirectly, could
result in damage to the sampling electronics and will void the Warranty.

2.6 Fuses

There are no external fuses or breakers accessible to the user. However, there are two internal automatic
thermal breakers that disconnect the power from the charger and battery to the rest of the system. These
thermal breakers make an audible click when they actuate. One of the circuit breakers automatically resets
after time. When this breaker cools, the CT100 can be restarted. There is also an internal breaker on the
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Safety Summary

battery charger board. If tripped, this breaker must be reset manually and the instrument should be
serviced by qualified personnel.

CAUTION: If the thermal breakers trip, the instrument should be evaluated
by qualified service personnel for maintenance.

>

2.7 AC Power Source

The CT100 is intended to operate only from a 120 VAC or 240 VAC RMS power source using the CE- and
UL-approved 24 VDC external power supply / adapter provided with the instrument.

WARNING: Only use the power cord supplied with the instrument, and
then only if the cord is in good condition. Refer all maintenance regarding
the power supply or power cord to qualified service personnel.

CAUTION: Use of any power source other than the supplied external
power adapter(s) could damage the instrument and may void the
Warranty. Use only MOHR-approved accessories.

WARNING: To reduce the risk of electric shock, disconnect all external
cables before connecting the 24 VDC external power supply.

> B B

2.8 Grounding the CT100

When the CT100 is connected to the external AC adapter, the CT100 chassis, front panel USB, screen,
and controls are grounded through the grounding conductor of the power cord. To avoid electrical shock, it
is essential that the protective ground connection is present when operating the unit under AC power.
When disconnected from external power, the CT100 is floating relative to earth ground, unless one of the
USB ports is connected to a grounded device. In this case, the ground of the USB device is common with
the CT100 chassis, screen, and electronic controls. An isolated ground power supply is an optional
accessory available upon request.

At all times, the front panel BNC or SMA connector is floating and is isolated by at least 500 VDC from the
remainder of the CT100. This eliminates measurement errors caused by common-mode noise and slight
ground-potential differences in the cable / device under test. However, care should be taken with respect to
electrical safety, as the front panel BNC or SMA shield is never safely grounded unless connected to a
safely-grounded cable or device and can be considered a second live conductor if connected to a cable or
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device carrying a non-zero electrical potential relative to earth ground. This situation carries the risk of
electric shock.

WARNING: The BNC or SMA connector shield represents a floating
ground and is never safely grounded even with the use of a properly
grounded AC adapter. Never use the CT100 to test any cable or device
carrying a non-zero electrical potential relative to earth ground, as this
could render an electric shock.

2.9 Danger Arising From Loss of Ground

When disconnected from the AC power adapter, the CT100 is no longer grounded unless connected to a
grounded USB device at the front panel host USB port. Because the BNC connector shield is floating
relative to the remainder of the instrument, the BNC connector may be operating at an elevated voltage
even when the AC adapter is connected. Therefore, the BNC connector should never be used to test any
cable or device with an electrical potential relative to earth.

WARNING: Upon loss of the protective-ground connection, all accessible
parts, including the screen, knobs, and connectors, can render an electric
shock.

2.10 Explosive Atmospheres
Do not operate the CT100 in an explosive atmosphere unless your unit has been specifically certified for

that condition. Explosive Atmospheres: MIL-STD 810G, Method 511.5, Procedure | (+55°C, sea level to
4600 m).

2.11 Do Not Remove Covers or Panels

To avoid personal injury and risk of electric shock, do not open the CT100 case and do not operate unless
the case is fully intact.

2.12 Connecting Cables to the Front Panel Test Port

To avoid damage to the CT100 and the very sensitive sampling electronics associated with the front panel
BNC or SMA connector, do not connect it to any cable or device that can be driven by active circuitry or is
subject to transient voltage spikes.

WARNING and CAUTION: The instrument should never be used to test
any cable or device carrying live electrical signals, as this carries a risk of
electric shock. This could also damage the sampling electronics and will
void the Warranty.
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CAUTION: Always properly ground the conductor(s) of any cable or wiring
to remove any static charge prior to connecting it, either directly or
indirectly through attachment to another cable, to the CT100's front panel
BNC connector. Failure to do so can damage the instrument's sensitive
sampling electronics and will void the Warranty.

2.13 Battery Replacement and Disposal

The CT100 contains a 2700 mA-h internal battery pack consisting of 12 AA NiMH batteries, as well as a
single lithium coin cell battery for the internal clock. Depending on the state or local jurisdiction, these
batteries may require special disposal and/or recycling. Contact your local authorities for safe disposal in
your area, or you may return them to MOHR for recycling.
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3 Operating Instructions

3.1 Overview

3.1.1 Handling

The CT100 is designed to meet the rigors associated with normal instrument use both in the field and on the
benchtop. Care should be taken to protect it from excessive mechanical shock, vibration, static electrical
charges, and water hazards.

The CT100 front panel is protected from impact by a snap-on front cover. The carrying handle rotates 360°
and can be used to support the instrument for bench-top use.

The CT100 is not watertight and must be protected against water spray. If the unit is subjected to water
spray, first turn off the unit with the battery-disconnect power switch on the rear panel and then drain all of
the excess water from the case and allow it to dry completely.

As noted in the Safety Summary and elsewhere, the CT100 and CT100HF are sensitive to damage
introduced by electrostatic discharge. Always properly ground the conductors of a cable to each other or to
earth ground before attaching it, either directly or indirectly, to the front panel BNC or SMA connector.
Failure to do so could damage the sampling electronics and void the Warranty.

The CT100 can be stored in temperatures of between -20°C to +60°C with or without a battery installed and
can be operated from 0°C to +50°C.

3.1.2 Powering the CT100

The CT100 can be powered through the included 120/240 VAC (RMS) to 24 VDC external power adapter.

This adapter has sufficient capacity to charge the internal battery from a dead battery state while the unit is
under operation. The internal battery will allow the unit to operate using power conservation techniques for
periods of at least 6 hours under typical use. Automatic power-down occurs after a variable amount of time
of inactivity, selectable in software by the user. The screen also can be set to turn off after a set amount of
inactivity. A heavily discharged battery will require 2.5 hours to reach full charge.

Fusing is internal and based on thermal reset switches and a manual-reset breaker. If one of these fuses
trips, it may indicate that a hardware malfunction has occurred and the instrument should be evaluated by
gualified personnel.

3.1.3 Caring for the Battery

The CT100 has an intelligent battery-charging circuit that dynamically determines the optimum charge rate
and reverts to low-level trickle charge when the battery is fully charged. Charging is automatic and there are
no charge-length restrictions.

The battery should be charged between 0°C and +45°C. Battery operation should be limited to between 0°C
and +50°C. Batteries should be stored between -20°C and +60°C. If the battery pack is older, it may not
show a 100% charge capacity even when the maximum battery charge is obtained.
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CAUTION: Do not attempt to charge the battery pack below 0°C or above
+45°C. Batteries should not be stored below -20°C or above +60°C.

3.1.4 Charging and Power Status

The CT100 operates from a 24 volt power adapter or the internal battery pack.

In the Power menu, a submenu of the Main menu, the user can set power save and shutdown timers.
Different time-out values can be set for when the CT100 is using the AC/DC converter or batteries. In power
save mode, the screen goes blank and only enough power is used to monitor for user input. When input is
received, the CT100 wakes back up. When the shutdown timer expires, the CT100 will turn off.

A battery indicator can be turned on and off with the Power Display menu option in the Power menu. The
indicator will show the level of charge in the battery. It will also show if the CT100 the 24 volt adapter is
attached and providing power.

3.1.5 Batteries and Long-Term Storage

The CT100 has NiMH internal batteries. These batteries will drain if the CT100 is left in storage over long
periods. To preserve battery charge for as long as possible during storage, make sure the power switch on
the back of the CT100 is set to the OFF position. After several months of storage, the internal batteries may
be completely drained. Allow up to 24 hours for the first recharge of the CT100 after coming out of long-term
storage.

3.1.6 Low Battery

When a low battery condition is first encountered, the CT100 alerts the user with a red warning. An “Internal
Battery Low” message appears when the battery percentage left drops below 20 percent.

3.2 License Codes

Each CT100 requires a unique license code to operate. Without the correct code, menus and buttons still
function, but there will be no live trace displayed on the screen. The correct code for a particular device can
be requested from MOHR. Installation instructions will be included with the license code.

Depending on how it was purchased, the instrument may be supplied with either a 30-day demonstration
license or permanent license. Current license information can be found by selecting the License option of
the Info menu. A dialog showing license date and active features will appear. When the CT100 has a
permanent license installed, appropriate options will be active. When the instrument has a demonstration
license, the dialog will show a future license date and the instrument will provide appropriate warnings to the
user as the expiration date gets closer. If your CT100 has a license with pending expiration and you are
unsure how to upgrade to a permanent license, please contact MOHR.
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3.3 Preparing to Use the CT100

Before using the CT100, make sure you have read and understand the Safety Summary section and power
requirements described in the previous sections. Then remove the front cover and turn on the power. You
are ready to test cables using the most versatile and sophisticated stand-alone TDR on the market.

3.4 Front Panel Controls and Connectors

The following numbered items describe the controls and connectors identified in the front panel diagram
(Figure 1) and described in the text below.
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Figure 1: Diagram of the CT100 front panel.

1) POWER (red) button. Pressing this button turns the instrument on when the main power switch on the
rear panel is in the ON position. Pressing the POWER button when the unit is on will turn the unit off. If you
have any unsaved traces, the unit will verify if you really wish to power down. If the POWER button is held

in for several seconds, the unit will turn off regardless.

2) H1 function button. Function depends on menu.
3) H2 function button. Function depends on menu.
4) H3 function button. Function depends on menu.
5) H4 function button. Function depends on menu.

6) MENU (blue) button. Push to display the top-level menu screen. Allows you to call up and navigate the

CT100's internal menus. This button also activates on-screen help when held down while pressing other
buttons.

7) VERTICAL POSITION knob. Controls the vertical position of the currently selected trace. Trace
selection is controlled by the SELECT button (14).
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8) VERTICAL SCALE knob. Controls the vertical scale, which is displayed on the bottom of the screen.
This control modifies the appearance of all traces on the screen. The scale is expanded about the vertical
center of the screen.

9) HORIZONTAL POSITION knob. Controls the horizontal position of the cursor and displayed trace
relative to the start position of the cable scan or relative to the connection to the unit.

10) HORIZONTAL SCALE knob. Controls the horizontal scale of the displayed traces; this scale is
displayed on the screen in either English or Sl units. The scale is expanded about the active cursor.

11) BNC or SMA test port. This connects to the cable you wish to test. Be sure to properly ground the cable
before connecting it to test port in order to prevent electrostatic damage to the CT100's sensitive sampling
circuitry.

CAUTION: All static charge must be drained from the cable to be tested prior to
connecting to the test port (11). This is done by shorting the cable center
conductor to the cable sheath/ground return. If this procedure is not followed,
the sampling electronics can be damaged and you will void the Warranty.

12) Host USB port. This USB (V1.1) connection can be used to interface to a client USB device such as a
barcode reader, keyboard, or thumbdrive.

13) LIBRARY button. Opens the Library menu, which contains a database of prior named configurations
and saved cable records (scans) and the records of known cable types.

14) SELECT button. Used to select between traces on the screen. It has no effect if there are no scanned
traces loaded.

15) CURSOR button. This button is used to toggle between the two available cursors.
16) SCAN button. Displays a specialized soft-menu that brings up the Scan and Trace menu.
17) AUTOFIT (orange) button. Fits short- or open-terminated cable to the screen extent.

18) M-FUNC (multifunction) button. The function of the M-FUNCTION knob (19) is set by this button. The
current operation is displayed on the screen.

19) M-FUNCTION (multifunction) knob. This knob adopts the function selected through the use of the M-
FUNC button (18).

20) V1 function button. Function depends on menu.
21) V2 function button. Function depends on menu.
22) V3 function button. Function depends on menu.

23) V4 function button. Function depends on menu.

3.5 Rear Panel Connectors and Switches

The following numbered items describe the connectors and switches identified in the rear panel diagram
(Figure 2) and described in the text below.
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Figure 2: Diagram of the rear panel of the CT100 / CT100HF.

24) External 14.4 VDC battery pack connection. Some older units may have this but it is no longer
supported and is not present on newer systems.

25) 24 VDC power adapter plug. The provided 24 VDC AC adapter plugs into this port. Only MOHR-
approved positive center tip, 24V adapters may be used.

26) Client USB connection. Allows the CT100 to be connected to a host computer for data transfer and PC
control.

27) RJ-45 Ethernet port. This is a 10/100 Mb Ethernet port that can be used for data transfer and remote
PC control.

28) Power switch. This is a manual ON/OFF power switch that turns the device off and prevents it from
powering on.

3.6 Setting up the CT100

3.6.1 Setting Date and Time

The date, time, and time zone must be accurately set for saved data in the CT100 to be correctly time-
stamped.

1) Change the date and time by pressing the MENU button. This calls up the Main menu.

2) Select the Info menu option using one of the eight menu hot keys, as labeled on the screen. The Info
menu appears.

3) Select the Time menu option. The Time menu appears.
4) Select the Set Time Zone menu option. A dialog box listing all time zones appears on the screen.
5) Use the M-FUNCTION knob to scroll through the list of time zones. Highlight the correct time zone.

6) Choose the Select menu option. The CT100 will prompt you to restart. After doing so, the CT100 will be
set to the correct time zone. Note that daylight savings should be turned on, and it will automatically
adjust for daylight savings on the correct dates.

7) After restarting the CT100, the time may already be correct, but if not, return to the Time menu by
pressing the MENU button, selecting Info, then selecting Time.
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8) Select the Time/Date menu option. A dialog box used to set the date and time appears. See the next
section for methods of navigating and entering data into a dialog box.

9) Press the OK menu option when the correct time and date have been entered.

3.6.2 Navigating Dialog Boxes

Scroll through the different entry boxes with the M-FUNCTION knob. With an entry box selected, press the
Keyboard menu option to call up an on-screen keyboard.

With the on-screen keyboard chosen, select the desired characters with the M-FUNCTION knob, pressing
the Select menu option for each one. Get more character options by selecting the Shift menu option. Delete
the character before the cursor with the Back menu option.

With the keyboard open, accept the current entry with the OK menu option or revert to the original entry with
the Cancel menu option.

With the keyboard off the screen, select the OK menu option to accept all changes to the current dialog box
and close the dialog box. Select the Cancel menu option to close the dialog box while canceling all
changes.

With a USB keyboard attached, entries can be changed directly. Use the tab key to scroll down through
entry boxes and hold down shift and press tab to scroll up through entry boxes. Use backspace to delete
the character before the cursor and use the arrow keys to move the cursor left or right. Press Enter for OK
or Escape for Cancel.

3.6.2.1 Scrolling Dialog Boxes

Some dialog boxes present a list of items to be selected. Use the M-FUNCTION knob to highlight individual
items for selection, then use the Select option to choose the highlighted item. Where appropriate, multiple
items can be marked for selection using the options on the right-side menu: Toggle Selected, Clear All,
Mark All, and Toggle All. When an individual item is marked, a symbol will appear in the last column of the
scrolling dialog box.

3.7 Display Features

The CT100 screen provides the operator with numerous features that may be useful in different cable
testing situations. Figure 3 shows some of the typical features you will encounter during testing. Many other
features are available, however, and most of them are configurable by the user. These features are
described in detail in the following sections.
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Figure 3: Screenshot showing typical features of the CT100.

3.8 Menu Selections and Function Buttons

3.8.1 M-FUNC Button

Used to switch between functions Shift (Trace), Change Vp (and Fine/Coarse Vp), and Smooth on the M-
FUNCTION knob screen function indicator.

The M-FUNC button has no effect if another function has captured the M-FUNCTION knob (see
descriptions of functions below).

3.8.2 SCAN Button an

d Menu

The SCAN button displays menu selections associated with saving and modifying TDR waveforms and
cable scan records. SCAN button menu selections are shown in Table 1.
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Table 1: SCAN Button and Menu.

1%' Level Menu
Selection

2" Level Menu
Selection

3 Level Menu
Selection

Purpose / Action

Save

Saves selected trace to flash memory.

Hide

Removes selected trace from screen. Does not delete.

Scan

Initiates cable scan.

Scan mode

Switches between scan modes:
Screen: Saves trace as seen on screen.
Cursor: Scans between cursors at screen resolution.

Custom: Scans between cursors at custom
resolution.

Add Scan Depth
Config

Adds a new custom scan depth (horizontal resolution)
to memory. User selects hame, resolution, units.

Select Scan Depth

Select a previously configured scan depth.

Show Sel. Trace
Only

Hide all traces except the currently selected trace.
Select again to unhide traces.

Math

Set Base

Sets selected trace as the base (denominator) trace
for math operations.

Difference

Creates subtraction trace from selected trace and
base trace (Difference = Selected — Base).

1% Derivative

Creates first derivative trace from selected trace.

Der. Smooth On

Toggles first derivative trace smoothing.

FFT Settings

Window

Sets type of window to apply to the FFT data.

Size

Sets FFT data size, padded with stationary values if
needed..

Apply FFT

Creates FFT trace from selected trace data between
cursors.

View Live FFT

Creates live FFT trace from live TDR waveform.

Set Base

Sets base trace for complex FFT waveform division.

Complex Division

Creates trace by dividing selected FFT by base trace,
equivalent to uncalibrated S;; waveform.

Phase

Creates phase angle trace from currently selected
FFT trace.

S-Param and
Normalize Tools

S;; Calibration

Performs OSL Si, calibration and creates S trace.

Normalize Pulse
Risetime

Set the rise time to apply to all normalized traces.

Cable Loss

Changes selected S;; trace to Cable Loss (S /
insertion loss) trace. Terminate cable with open or
short for meaningful results.

Hide

Hide the selected trace.

16
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1% Level Menu

2" Level Menu

3 Level Menu

Purpose / Action

Selection Selection Selection
Apply S11 Create S, trace using the current Sy, calibration.
Apply Create normalized TDR trace based on the selected
Normalization S, trace.
Smith Chart Draw the selected S;; trace on a Smith chart.

Layer Peeling

Create layer peeling trace from selected waveform.
Assumes active cursor (layer peel start) is set at 50
ohms.

3.8.3 SELECT Button

The SELECT button switches which trace on-screen is the active trace.

3.8.4 AUTOFIT Button

Automatically adjusts the TDR resolution to fit an entire cable from beginning to end (identified by open or
short termination) on the screen. Pressing the AUTOFIT button a second time while autofitting will put both
cursors visibly on the screen. If the AUTOFIT button is held down for one second then released, the CT100
will vertically center the currently selected trace at the active cursor. More information can be found in the
section describing the Vertical Correction menu below.

3.8.5 CURSOR Button

Toggles between cursors, making the active cursor inactive and the inactive cursor active. Pressing and
holding the CURSOR button for one second then releasing will move any cursors not on the screen to the

screen.

3.8.6 LIBRARY Button and Menu

Use this menu to access the user library of configurations, cable types, and cable records. LIBRARY button
menu selections are shown in Table 2.

Table 2: LIBRARY Button and Menu.

1%' Level Menu

2" | evel Menu

3" Level Menu

Purpose / Action

Selection Selection Selection
Add Custom Use to add a new custom cable type to the custom
Cable Type cable type library.
Load Custom Use to select a user-defined cable type.
Cable Types
Configurations Use to load a previously defined user configuration.
Cable Types Use to select a built-in cable type.

Cable Records

Use to load a previously saved TDR waveform.

Save Config

Saves the current configuration of the instrument
under a new user configuration.

CT100/ CT100S / CT100HF Operator's Manual
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3.8.7 MENU Button and Top-Level Menu

If no menu is displayed, MENU loads the main top-level menu. If the top-level menu is displayed, it closes
the menu. If a submenu is displayed, it displays the parent menu. Top-level menu selections are listed
below in Table 3. Holding down the MENU button while pressing any button (or the M-FUNCTION knob)
will display a help dialog for that button's current menu selection.

Table 3: MENU Button and Menus

1°' Level Menu
Selection

2" Level Menu
Selection

3" Level Menu
Selection

Purpose / Action

CABLE LEN

Sets cable length mode:

Short: For cables of up to 305 ft. (93 m) long.
Medium: For cables up to 1600 ft. (488 m) long.
Long: For cables up to 6,459 ft. (1,969 m) long.

[Note: Access Extra Long mode in the Measurement
submenu. Use Extra Long mode for cables up to
40,452 ft. (12,330 m) long.]

DEPTH

Sets TDR waveform horizontal sampling resolution:
Classic: Screen resolution (1 sample/pixel).

Cable: Optimal setting for cable and connector detail
(17.5 ps, ~2 mm). Stays fixed regardless of screen
horizontal scale.

Fixed: Set manually using M-FUNCTION knob, stays
fixed regardless of screen horizontal scale. Useful for
enhancing frequency resolution of S;; waveforms.
Full Scan: Same as Fixed mode except that full
waveform encompassed by screen when Full Scan
mode was entered is always scanned, regardless of
horizontal position or scale.

[Note: TDR frame rate is reduced at higher sample
depth settings due to increase sample count.]

Display and Power
Settings

Display

Print Screen

Prints screenshot to USB PCL-3 compatible printer.

Ohms/Rho Toggles display of impedance (ohms) and reflection
coefficient (millirho) at cursor and between cursors.

Time/Date Toggles time/date display.

more Cycles through additional selections.

Scale Toggles display of horizontal, vertical scales and VoP.

Intersection Toggles display of cursor-waveform intersection.

Decibels Toggles display of decibel (dB) values at cursor.

Temperature Toggles display of instrument internal temperatures.

18
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1% Level Menu

2" Level Menu

3 Level Menu

Purpose / Action

Selection Selection Selection

Distance/ns Toggles display of distance and time (ns) at cursor.

VSWR Toggles display of VSWR (voltage standing wave
ratio) at cursor.

Temp Comp Toggles display of Temp Comp autocalibration status.

Change Screen Toggles screen background (black, gray, white).

Profile

Horiz. Vert. Ruler | Toggles display of horizontal and vertical rulers.

Noise Value Toggles display of noise value at cursor for diagnostic
purposes.

Power

DC Power Save Sets the inactivity timeout for power save mode while
the device is running on external DC supply.

DC Shutdown Sets the inactivity timeout for shutdown while the
device is running on external DC supply.

Battery Power Sets the inactivity timeout for power save mode while

Save the device is running on batteries.

Battery Shutdown | Sets the inactivity timeout for shutdown while the
device is running on battery.

Power Display Toggles on the on-screen power status display.

Battery Icon/ Toggles between voltage or battery icon display.

Power Units

Connections

Server Select

Choose which CT Viewer server to connect to. If the
connection succeeds, a message appears on the CT
Viewer screen.

Add Server Add a new connection to the Server Select list:
Server Name: Connection nickname.
Server Address: IP address of CT Viewer server.
Port Number: TCP port number (default 55556).

Push Test Select to move a single saved trace from the CT100 to

the connected CT Viewer database.

Push All Tests

Select to move all saved traces from the CT100 to the
connected CT Viewer database.

Network Settings

Static Network

Modify static network settings (if DHCP inactive):

Settings IP Address: IP address (XXX.XXX.XXX.XXX)
Netmask: Subnet for CT100
Gateway(optional): Gateway server for CT100
Nameserver 1&2(optional): Nameservers for CT100
DHCP * Toggles DHCP on/off.

Show IP Config

Displays current Ethernet configuration.

Set Listen Ports

This dialog box allows you to define a different RPC
Port # and a different Remote Control Port # for use
with the CT Viewer application (default 12347)

CT100/ CT100S / CT100HF Operator's Manual
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1°' Level Menu
Selection

2" Level Menu
Selection

3" Level Menu
Selection

Purpose / Action

SP232 Protocol
On/Off

Toggles SP232 emulation on/off. A USB to serial
adapter is required for SP232 emulation. Pressing this
button while the SP232 emulation is on will switch the
baud rate.

Web Export
On/Off

Activates and toggles function of web server. When
active, you can access the following web pages:

Live trace data:
http://<<IP_addr>>/wwwi/trace.csv -- live TDR trace as
comma-separated values (CSV).

Selected trace data:
http://<<IP_addr>>/www/selected.csv -- selected TDR
waveform in CSV format.

Screenshot:
http://<IP_addr>/www/screenshot.bmp — bitmap image
of the current TDR screen.

The button toggles Web Export into three states:
On: Normal operation (~2 frames/sec).

Fast Mode: Fast refresh (~7 frames/sec).

Off. Web server not active.

[Note: Web Export is only one means of interfacing to
the CT100. Please see the CT Viewer manual for
information on how to use CT Viewer to remotely
control and view TDR waveforms from the CT100.
See www.mohrtm.com for information regarding the
CT100 Python programming library and binary
programming protocol for directly interfacing to the
CT100 via Ethernet.]

Measurement

Vert. Ref.

Menu for Vert. Ref. (VR) mode settings. VR mode
uses short/open calibration to improve vertical
measurement accuracy.

Vert. Ref Off/On

Toggles VR mode on/off. Must use Set Vert. Ref.

Set Vert. Ref.

Performs VR calibration using short/open terminators.
When setup is complete, green vertical line indicates
start of VR measurements.

Vert. Ref. Center
Imp.

Adjusts VR calibration to use impedance matching
adapters and baluns. Adjust to match the output
impedance of the adapter.

Vert. Ref. Start

Sets start of VR measurements. Green vertical line
will be moved to the position of the active cursor.

Cable Segments

Menu for multisegment cable measurement settings.
Useful for cable runs with cables of different Vp in
series.
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1% Level Menu
Selection

2" Level Menu
Selection

3 Level Menu
Selection

Purpose / Action

Add New Segment

Create a new segment boundary at the location of the
active cursor. The segment that the cursor is in will be
split in two. Both segments will start with the same Vp,
but the Vp for each segment can now be changed
independently from the other.

Delete Segment

Delete the currently selected segment. The segment
will be merged with the segment to the left.

Delete All Delete all segments. The CT100 will return to normal
Segments operation. A single Vp now applies to the entire trace.
Select Prev Select the segment to the left of the currently selected
Segment segment.

Select Next Select the segment to the right of the currently
Segment selected segment.

Reset All Vp Reset the Vp of all segments to 1.000.

Restore All Vp

After pressing Reset All Vp, this option will restore Vp
of all segments to the previous values.

Extra Long Mode

Extra Long Mode allows the CT100 to obtain traces
out to 40,452 ft. or 12,330 m (Vp 0.66). Extra Long
Mode is slower than other cable modes and some
instrument features are not available. When in Extra
Long Mode, the Cable Length menu option will
indicate Extra Long Mode On. Selecting the cable
length menu item will switch away from Extra Long
Mode.

Set Cursor X Pos.

Envelope Plot

Envelope plot mode captures transient cable and
connector faults.

Envelope Plot

Enable/disable envelope plot mode. When turned on

Off/On the CT100 begins capturing trace data and displaying
envelope plot information.
Reset Deletes/restarts captured TDR trace envelope data.

Fill Mode Off/On

Toggles between fill and probability density plot mode.
Use fill mode for finding magnitude of impedance
change and highlighting fault location. Use probability
density plot mode for finding infrequent transient
faults.

Ztrace Off/On

ZTrace transforms a time domain trace from reflection
coefficient (millirho) to impedance (ohms) in the
vertical dimension. This works on saved or live traces.

Vp 3/6 Figs Toggles velocity of propagation between 3 and 6
significant digits.
Units Toggle TDR waveform between different horizontal

(meters,feet,...)

measurement unit options.

Legacy Options
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1°' Level Menu

Selection

2" Level Menu
Selection

3" Level Menu
Selection

Purpose / Action

RRC method

Toggles relative reflection coefficient calculation
modes:

Classic: The measurement is related to the input
signal at the fault.

1502C: The measurement is scaled to the input signal
at the test port (as in the Tektronix® 1502C TDR).

Vertical
Corrections

This menu contains options for adjusting or correcting
vertical measurements to enhance the accuracy of
reflection coefficient and impedance measurements.

Adjust Q/(unit)

Resistive cable loss correction is useful when
examining long and/or lossy cables. When activated,
the ohms-per-unit distance tool will correct for resistive
loss down the length of the cable. The correction
always extends from the test port (distance=0) to a
position that can be fixed using other menu
commands below. When activated, the end position
will be displayed on the screen in a distinctively
colored vertical line. This correction requires accurate
velocity of propagation (Vp) measurements and
accurate vertical measurements. It is therefore best
used in conjunction with a vertical reference (see
above).

Use the M-FUNCTION knob to change the ohms per
unit distance loss setting for a cable.

This tool may also be used to estimate resistive loss in
a cable by adjusting the value until the cable shows no
upward or downward trend across its length.

Q/(unit) Correct.
On/Off

Toggle resistive cable loss correction on/off, as
described above. If the end point of the correction has
not been set, then it will be set to the position of the
active cursor.

Set Q/(unit) Pos.

Set the position of the ohms/(unit distance) position to
that of the active cursor.

Adjust Rho Offset

The adjust rho offset option allows manual vertical
measurement offset adjustments. This allows
advanced users to manually calibrate impedance
measurements at a particular location to a known
value.

When activated the M-FUNCTION knob adjusts the
vertical offset. The blue M-FUNC indicator shows the
offset in millirho. Changing the rho values will change
all vertical measurements including impedance, return
loss, voltage, standing wave ratio (VSWR), and
relative reflection coefficient (RRC).

The adjusted value is never saved; restarting the
CT100 will cancel the adjustment. When this
correction is in use, automatic temperature adjustment
will not correct vertical readings. A message that rho
measurements are being manually adjusted will
appear near on-screen measurements.
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1% Level Menu

2" Level Menu

3 Level Menu

Purpose / Action

Selection Selection Selection

Cancel Rho Offset | Use this option to cancel a manual rho correction.
Automatic temperature adjustment will resume auto-
correction of the vertical measurements.

Auto Vertical This option is now obsolete.

Correction On/Off

Force Vertical This option is now obsolete.

Correction

Diagnostics
Analog Run automated diagnostics on the analog trace
acquisition circuit board. Results are displayed on-
screen in a message box.
Main Board

Memory Run automated diagnostics on the main circuit board's
memory interface. Results are displayed on-screen in
a message box.

GPIO Run automated diagnostics on General Purpose 10
pins connected to the main circuit board. Results are
displayed on-screen in a message box.

Peripherals Run automated diagnostics on main circuit board
peripherals. Results are displayed on-screen in a
message box.

Database

Clean Database

This option defragments the database, freeing up
unused space, then turns off the CT100. For daily use
this option is not necessary. Use clean database only
when the CT100 is plugged into a power supply. Do
not shutdown the CT100 while a clean database is in
progress.

Front Panel Check

This item opens the front panel button and knob check
screen. Hit each button once and turn every knob in
each direction. Press the red power button to exit
when finished.

Jitter

Jitter measures signal noise, timebase jitter, rise time,
and sampling efficiency of the trace. These values are
used as part of the calibration checkout for the CT100,
and results of interest are explained in the system
technical manual.

Calibration

For a full description of this menu, please see
technical manual Appendix F: Calibration Procedures.

CABLE LEN

Cable length setting.

Manual Calibration

Manual calibration settings:

CABLE LEN: Cable length setting.

D-COMP: Driver start calibration.

S-COMP: Sampler compensation.

H-COMP: Pulse reference voltage compensation.
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1°' Level Menu
Selection

2" Level Menu
Selection

3" Level Menu
Selection

Purpose / Action

Temp Adjust
On/Off

Toggles temperature adjust on/off. Temperature
adjust should be turned off for calibration, except for
horizontal calibration.

Vertical Calibration

Step-by-step process with on-screen directions.

D-COMP

Step-by-step process with on-screen directions.

S-COMP

Step-by-step process with on-screen directions.

H-COMP

Step-by-step process with on-screen directions.

Horizontal

Step-by-step process with on-screen directions.

Info

License Info

This option gives information about the license
installed on the CT100, including the license date and
enabled options.

License from USB

Use this option to load a license code from a USB
flash drive. Detailed instructions will be provided with
the license code.

Web Update

When a CT100 is connected to the Internet, this item
will automatically update the CT100 if newer software
is available.

Enter License

Manually load a license code. This is useful for
operators who are unable to connect to a computer or
use a flash drive.

Software Version

Display software and firmware version information.
This also serves to verify the communications links
between the micro-controllers.

Hardware Info

Display hardware information.

Usage

Display usage stats (hours, scans, storage, etc.).

Time

Set Time Zone

Change the time zone. Requires a reboot for changes
to take effect.

Daylight Savings
On/Off

Sets adjustment for daylight savings time on/off.
Requires a reboot for changes to take effect.

Time/Date

Set the current date and time.

Math

See section for Scan Button and Menu, page 15.
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3.9 TDR Measurement Background

The purpose of this section is to familiarize the operator with the basic theory of time-domain reflectometry
measurement theory in preparation for using the instrument.

3.9.1 Time-Domain Reflectometry (TDR)

TDR is a form of closed-circuit radar in which a transient test signal is injected in to a device-under-test
(DUT) such as a cable, and reflected voltages are measured over time to construct a TDR waveform or
“trace”. Assuming a transmission line such as a cable with uniform geometry, the test signal propagates
with a characteristic velocity such that the time can be related to distance. The changes in reflected voltage
in a TDR waveform with respect to time correspond to distance from the test port where impedance
changes.

Cable or connector faults are regions where the measured reflection coefficient and associated impedance
are outside of manufactured specification. Cable faults are almost always broadband with preferential
attenuation of higher frequencies, and indicate one or more of the following problems:

1) Change in the geometry of the conductors with respect to one another,
2) Change in the dielectric properties of the insulator, and/or
3) Partial or complete interruption in one or both of the signal conductors.

Cable faults are important because they degrade signal quality. Short or open faults obviously completely
disrupt signal transmission. In many ways such “hard” faults are helpful because they are easy to diagnose.
However more subtle partial or “soft” faults cause portions of the signal energy to be reflected and/or
transmitted contributing to noise. This can show up as reduced bandwidth and increased bit error rates.

It should be noted that multiple small faults that are individually insignificant with respect to noise may
contribute in an additive fashion to significant problems. Because TDR typically measures the transmission
line with sensitivity well below the bit error threshold, it is useful to find these “insignificant” faults and
deviations from manufactured specification that may contribute to signal integrity problems.

3.9.2 Reflection Coefficients

The amplitude of reflected voltage at a particular location in a TDR waveform is determined by the reflection
coefficient at that location. The CT100 displays reflection coefficient in the upper right hand of the screen
with units of millirho (mp) and relative reflection coefficient with prefix of “RRC”.

The reflection coefficient is the ratio of the amplitude of the reflected portion of the test signal to the
amplitude of the incident test signal. The reflection coefficient (Gamma, I') is related to the impedance
change (Z) at a given point in a cable according to:

ZL— Zs

=
Z, + Zg

Where Z, is the impedance of the load (e.g., the device under test [DUT]) and Zs is the source impedance
of the TDR, typically 50 ohms but potentially other values if an impedance matching adapter is being used.
The reflection coefficient uses units of rho (p) or millirho (mp).

Note that the reflection coefficient (') is a complex variable with unique amplitude and phase for each
frequency. However, when measuring reflection coefficient directly from a TDR waveform the measured
value is the average reflection coefficient over all frequencies in the incident and reflected test signal.
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The CT100 is also able to measure and display frequency-domain complex reflection coefficient values in
the context of S;; / return loss and cable loss plots such as those produced with Vector Network Analyzer
(VNA) and Frequency Domain Reflectometer (FDR) equipment. This is discussed in further detail on
page 31.

3.9.3 Common Types of TDR Cable Faults

Open faults appear as a pulse upward in the TDR trace (Figure 4) because the fault reflects all of the
incident step energy in-phase with the test signal.

Yp 0,700 7735 ft
: 22469 ns
7,735 Aft
22,469 Ans
= 1.5k
9523 mp
0.3 dB

; E ST AT VoW

: : 41.004 rvswR

5 § RRC 952,38 mp
B S ] L Ot RRE-SaedE
i : [961.3, 962.2) mp

961.9+1.1 mp

145 ftjdiv | LIVE TRACE;D.?DD Wp 300.0 mpfdiv

yiehExp: BMP,CSy

Figure 4: An open cable fault.

Short faults appear as a pulse downward in the TDR trace because the fault reflects all of the incident step
energy out-of-phase with the test signal (Figure 5):

Wp o 0,700 7735t
22,469 s
7.735 Aft

22,469 Ans
180

9302 mp

0.6 dB

27 656 WSYWE
31.238 rvSWR
: : RRC -937.96 mp

B I e e e By e I RRL =3 5df

wiehExp: BMP, Coi

[SE ; {-930.5, -930.2) mp
S § \ -030,3+0.3 mp
1.45 ftidiv LIWVE TRACE;D.?DD W 500.0 mpfdiv

Figure 5: A short cable fault.

Short or open faults measured through long lengths of cable will show long, shallow reflections on the TDR
waveform because the cable preferentially attenuates higher frequencies in the test signal, degrading the
rise or fall time of the reflected fault. Figure 6 demonstrates a TDR trace with an open fault at the end of a
1000 ft. relatively lossy coaxial cable with long, shallow reflected rise caused by cable attenuation of high
frequency components of the step pulse.
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Figure 6: An open cable fault at 1000 ft.

Faults with reactive components such as capacitance and inductance appear as either transient dips or
exponential curves above or below the characteristic impedance of the cable depending on whether they
are in series with the conductor or represent a fault to ground.

Normal connectors will show up as an impedance discontinuity simulating a fault. Depending on the type
and quality of the connectors, the expected impedance variation will differ, as shown in Figure 7 and Figure
8 for SMA and BNC type connections. Connector damage and corrosion will change the impedance profile
of connectors over time and surveillance using TDR with attention to historical comparison can be helpful.
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0,418 ftfdiv LIVE TRACE|0.700 W 7.3 mp/div

Figure 7: Normal SMA female barrel interconnect measuring ~0.4 ohms.
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Figure 8: Comparison of typical SMA and BNC coaxial cable interconnects.

Soft / partial faults typically will not appear at the end of the trace after pressing the AUTOFIT button, but
instead can appear anywhere along its length.

Any fault has the potential to reduce the incident pulse strength for subsequent cable faults and may
change the apparent velocity of propagation. The accuracy of the Distance-to-Fault measurement of a fault
that appears beyond another fault is reduced.

3.9.4 Velocity of Propagation (VoP, Vp)

As mentioned above, a transmission line such has a cable has uniform geometry with a characteristic signal
propagation velocity. This velocity of propagation (Vp), also sometimes abbreviated VoP or VP, and
sometimes also called the velocity factor (VF) and wave propagation speed, is the measure of the velocity
of an electrical signal within a cable expressed as a fraction of c, the speed of light in a vacuum. With the
CT100, Vp can be set in ranges between 0.25 and 1.0.

Nominal Vp values for most types of cable can be found in the manufacturer’s data sheet, and Appendix E
contains nominal values for a variety of commonly used cable types. These values can be a good start for
basic cable Distance-to-Fault measurements, however it is important to be aware that Vp values for a given
cable type may vary from manufacturer to manufacturer and from one manufacturing lot to the next even
from the same manufacture. In addition cable aging due to temperature, radiation, or other environmental
parameters may alter the original characteristic velocity of propagation for a given cable. For this reason if
accuracy is particularly important for a particular cable Distance-to-Fault measurement, it is generally a
good idea to establish a known Vp for a sample of the specific cable under test.

The velocity of propagation (Vp) is related to the dielectric constant (relative permittivity, €,) of the dielectric
medium according to:

1
Ver
Velocity of propagation is also related to the distributed inductance (L) and shunt capacitance (C) of a
lossless transmission line according to:

Vp =
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3.9.5 Distance-to-Fault (DTF) and Cable Length

Once the operator identifies a impedance discontinuity such as a cable fault or open or short cable
termination, the distance to the fault (D) is related to the velocity of propagation (Vp), the speed of light (c),
and the measured round-trip time (t) to the fault, according to:

D—lV t
_.2 p-cC

3.9.6 Impedance

As mentioned previously, TDR instruments measure reflection coefficient essentially directly but must
calculate impedance according to:

re)+1
Z(t) = —Z¢—7—
This is the basis for the CT100 ohms-at-cursor measurements and ZTrace impedance waveforms. It is
important to note that impedance is nonlinear with respect to reflection coefficient, as shown in Figure 9.

Because TDRs measure reflection coefficient, noise and uncertainty on a TDR trace is in units of millirho,
not ohms. Given a fixed amount of uncertainty in reflection coefficient, the corresponding impedance
uncertainty will be low below the TDR source impedance (typically 50 ohms) and increasingly larger and
nonlinear for impedance values above the TDR source impedance.

The CT100 factory calibration typically provides acceptable accuracy of 1 ohm or 1% (whichever is larger)
from zero to 1000 ohms in many cable testing applications, however when impedance measurements are
very important, accuracy can be improved using Vert. Ref. (page 49) and normalized TDR waveforms
(page 55).
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Figure 9: Relationship of impedance (ohms) to reflection coefficient (rho) for 50 ohm source
impedance (marked by red circle).
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3.9.7 Return Loss

Return loss is another way of measuring impedance change in a cable. Return loss is given in decibels (dB)
and is always calculated using the relative reflection coefficient. Return loss is related to the reflection
coefficient I' by the formula:

Return Loss = —20-log,,|T'| dB

The larger the fraction of energy in the reflected signal, the lower the numerical return loss value, so that an
open or a short that returns 100% of the signal has a return loss of 0 dB. A very low loss cable will have a
large return loss in dB. Likewise a 50 ohm cable terminated with a perfect 50 ohm load will have very large
return loss in dB. This relationship is shown in Figure 10.

Return loss measured directly from a CT100 TDR waveform represents the average return loss over all
frequencies in the step-rise test signal. The CT100 can measure TDR return loss at cursor and relative
return loss between cursors and optionally displays these values at the right hand of the screen in units of
dB, with prefix of “RRL” for the relative return loss measurement.

The CT100 is also able to measure complex frequency-specific S;; return loss and cable loss values such
as those produced with Vector Network Analyzer (VNA) and Frequency Domain Reflectometer (FDR)
equipment. This is discussed in further detail on page 31.
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Figure 10: Relationship of return loss (dB) to reflection coefficient (rho).

3.9.8 VSWR

Voltage standing wave ratio (VSWR) is a way of displaying reflection coefficient in a nonlinear way that
emphasizes changes in cable impedance. VSWR is the voltage standing wave ratio and is related to the
reflection coefficient [" according to:

1+ [T
1—1T]
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VSWR measures the ratio of the maximum-over-time amplitude of the nodes and anti-nodes of the standing
wave off of a reflection. If there's no reflection (e.g. 50 ohm termination), VSWR will be 1. If all energy is
reflected (e.g. short or open fault), VSWR goes to infinity. This relationship is shown in Figure 11. VSWR is
a unitless, scalar value.

The CT100 displays two different VSWR values at cursor. The first, VSWR is calculated from the total
reflection relative to the CT100 test port source impedance (50 ohms). The second, RVSWR is calculated
from the reflection between the two cursors. In other words, VSWR is based on the millirho reflection
coefficient, while RVSWR is based on the RRC, relative reflection coefficient calculation. There are menu
options in the Display menu to toggle the display of VSWR and RVSWR.
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Figure 11: Relationship of voltage standing wave ratio (VSWR) to reflection coefficient (rho).
VSWR for 50 ohm load is shown by the red circle.

3.9.9 Frequency-Domain Measurements

3.9.9.1 Scattering Parameters

The scattering parameter or S-parameter approach to describing a device under test (DUT) assumes that a
DUT is a black box network with N ports. The S-parameter matrix contains the complex reflection and
transmission coefficients of the network, describing the amplitude and phase of reflected and transmitted
values from each port in response to excitation of one or more of the ports.

According to convention, the scattering parameter S, represents the response of the network in terms of
reflected and/or transmitted voltages at port x in response to excitation of porty. S;; and S,, are the
complex reflection coefficient matrices of port 1 and 2, respectively. S,; and S, are the forward and
reverse complex voltage gain matrices for port 1 and port 2, respectively.

Considering 2-port network with indent voltage waves a; = V;" and a, =V,  and reflected waves being b; =
Vi and b, = V3, the 2-port S-parameter matrix is described by:
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(2

(511 512> (al)
S1 S22/ \a2
Solving for Sy, gives:

_ b, _ Vi
w a; - V1+

Solving for Sy; gives:

b, Vy
S = —_—= —
2t a, Vi
Passive networks like cables, splitters, attenuators, and combiners can be considered reciprocal networks
such that S;; = S,, and S,; = S;». One-port measurements can be used to characterize the return loss
(S11/S22) and insertion loss (S,1/S;2) of a variety of 2-port passive networks such as cables as discussed
under the following Cable Loss section.

Practically speaking, S-parameters are measured directly in the frequency domain by a VNA instrument and
in the time domain by a TDR instrument. The TDR instrument then performs a discrete Fourier transform
(DFT) operation to decompose a TDR waveform into the frequency domain.

When calibration is performed at the test plane using open, short, and 50 ohm load (OSL) terminations, the
CT100 is able to mathematically subtract systematic errors in the pulser and sampler electronics from the
measured waveform, improving S-parameter accuracy.

3.9.9.2 Return Loss (S11)

The complex return loss Sy, is expressed as:
Return Loss RL = —20 -log,,|S11|dB

3.9.9.3 Insertion Loss (S21)

The complex insertion loss S,; is expressed as:

Insertion Loss IL = —20 -log4|S2,|dB
True 2-port insertion loss measurements require a 2-port instrument; however the Cable Loss measurement
described below uses the reciprocity feature of passive networks to determine insertion loss from cables
and other suitable 2-port networks using a 1-port test instrument.

3.9.9.4 Cable Loss (S21)

Cable insertion loss in dB is additive per unit length. Assuming that port 2 of a 2-port DUT (e.g. a coaxial
cable) is terminated with a short (or open) adapter such that all (or nearly all) of the incident voltage
waveform is reflected back to the TDR instrument, insertion loss (S,;) is half of the corresponding S;; return
loss measurement in dB:

RL
Cable Loss CL = TdB

Again, this relationship is valid if the cable is terminated with a short or open. One drawback to this
technique is that the round-trip insertion loss reduces the length of cable that can be tested over a given
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bandwidth relative to a 2-port measurement because the attenuation of the test signal is doubled. However
for many applications it is more than adequate.

3.9.9.5 Smith Charts

The impedance Smith chart is a useful graphical tool for visualizing complex impedances and scattering
parameters according to Figure 12. The CT100 includes Smith chart functionality that can be used to
simplify transmission line troubleshooting and impedance matching as described in Section 3.11.19 .
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Figure 12: Impedance Smith chart relationships.

3.9.10 Normalized TDR Waveforms

The S-parameter OSL calibration process mathematically models the TDR pulser-sampler system as a two-
port error network and subtracts systematic pulser-sampler errors from the S;; matrix. Convolution of the
S11 matrix with an idealized Gaussian step or other idealized excitation signal allows the CT100 to create
and display a normalized TDR waveform. The normalized TDR trace has lower aberration and improved
impedance accuracy. By changing the risetime of the Gaussian step, the effect and importance of a given
cable or connector fault can be estimated at different signal rise times and bandwidths.

3.9.11 Layer Peeling / Dynamic Deconvolution

Layer peeling or dynamic deconvolution is a general method to solve the inverse scattering problem in
partially reflective transmission lines. In general, when applied to TDR waveforms, this method attempts to
extract the underlying real reflection coefficients and impedance in the presence of multiple reflections
caused by the presence of impedance discontinuities.

As implemented in the CT100 (see Section 3.11.22 , the method iteratively examines the TDR waveform at
each time step and attempts to correct for forward and backward signal propagation to extract impedance
values at each time step. This is diagrammed in Figure 13 showing measured voltages v(t) taken from the
TDR waveform and their relationship to actual reflection coefficients (I') at time (t) and impedance values
(Zx) at different physical distances.
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The resultant TDR waveform partially corrects for the presence of multiple reflections and can be expected
to provide more accurate impedance values.
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Figure 13: Layer peeling scattering diagram.

3.10 Test Preparations

3.10.1 Connecting to the Cable or Device-Under-Test (DUT)

The first and most important decision to make when testing a cable or other device-under-test (DUT) is how
to connect to the DUT. Because the connection to the DUT acts as a filter for the test signal into and out of
the DUT, it is very important that the connection have the highest bandwidth and least aberration
possible.

Controlled impedance connections are recommended whenever possible. Controlled impedance
connections have conductors with uniform geometry and dielectric properties that do not change
significantly during a test session or between test sessions. Examples of controlled impedance connections
include coaxial-coaxial adapters, coaxial-twisted pair adapters, and fixed-pitch TDR probes.

Alligator clip and clip lead adapters with flexible wire test leads should be used only as a last resort.
Alligator clip and clip lead adapters are not made for high frequency operation, are severely bandwidth
limiting, and introduce severe aberration and measurement uncertainty into the TDR waveform. Figure 14
shows a comparison test of a coaxial cable using clip lead adapters (red) and a controlled-impedance
adapter (white). The clip lead adapter TDR waveform is severely degraded.
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Figure 14: Clip lead adapter (red) and controlled-impedance adapter (white) testing
of 3 ft. coaxial cable with short termination. Active cursor is at the test port. Clip lead
adapters introduce severe TDR waveform distortion.

3.10.2 Change Velocity of Propagation (Vp)

The current setting for Vp appears on the lower center of the screen. Press the M-FUNC button until the

top-center information indicator reads “Vp.” If Fine Vp is enabled from the Measurement menu, two “Vp”
indicators will be separately available. Coarse Vp allows for the modification of the first 3 significant digits
and Fine Vp allows for the modification of the last 3 significant digits.

Turn the M-FUNCTION knob and the Vp value will change accordingly. Measurements and traces are
automatically updated on the display to reflect the new Vp.

An accurate Vp is necessary for accurate cable length and Distance-to-Fault measurements. For cables of
a known type, the Vp can be approximated by using the nominal Vp for that cable type. The CT100 has a
built-in library of cable types and their Vp values. See the Cable library section below. You can also
measure the Vp by testing a known length of cable that is of the same type as the one you want to test. The
method is described in the following Find an Unknown Velocity of Propagation (Vp) section.

3.10.3 Find an Unknown Velocity of Propagation (Vp)

This method is used to find the Vp for cables under test where the Vp is entirely unknown. It requires a
sample cable that is of the same type that can be measured physically.

1) Measure the length of the test cable. Make sure the test cable is of the same type for which you
need to find Vp. If there are any adapters used while connecting the cable, include their length in the
measurement, or set one of the cursors at the end of the adapter before attaching the cable.

2) Attach the test cable to the CT100.
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3) Press the AUTOFIT button. The CT100 will now show the beginning and the end of the test cable
(Figure 15). The cable end, in this case an open termination, has been found at 2.812 feet and the
cable has been fit to screen.

shift 2,812 ft

e H 2.603 n:

231-312-325 5 2.748 Aft

T : 8467 Ans

E : 5150

i 15.2.mp
o :

: RRZ 3.30 mp

H RRL 43.6 dB

"::ii: ____________________________________________________________________________________________________________

0.358340 ftfdiv LIVE TRI—‘«CEEEI.&E'D s} S00.0 mpfdiv

Figure 15: Screenshot showing AUTOFIT result.

4) Position the active cursor at the end of the test cable. Use the HORIZONTAL SCALE knob to zoom
in on the end of the cable and get an accurate placement (Figure 16).

shift 2.844 ft

1-15-2015 8,762 s
733248 2,781 Aft
e 2,907 Ans
557 0

. S35 mp
s 29.4 dB
0.0543 ft/div LIVE TRACEID.G60 Vi 500.0 mp/div

Figure 16: Use of the HORIZONTAL SCALE knob to improve
Vp accuracy.

5) Adjust Vp until the CT100 distance measurement to the active cursor equals the physical
measurement. The final Vp value is the true Vp value of the cable.

3.10.4 Smooth Settings

The CT100 smoothing feature performs an exponential smooth on the waveform to decrease visible noise
on the live TDR waveform and improve signal-to-noise ratio (SNR) for first derivative, Sy, return loss, and
other mathematical operations. When you acquire baseline TDR scans of cable assemblies meant for
archiving and future comparison use, it is recommended that at least a moderate level of smoothing be
used so that the vertical resolution of the instrument be used to the fullest extent possible. The effect of
smoothing is most apparent at high vertical gain settings. To change TDR waveform smoothing:

1) Press the M-FUNC button until “Smooth” shows up in the upper middle of the screen.
2) Rotate the M-FUNCTION knob until the desired level of waveform smoothing is obtained.
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A comparison of a smoothed (1,024 waveform average) TDR trace to an unsmoothed TDR trace at high
vertical gain is shown in Figure 17.
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030573 injdiv SAVED TRACED.700 ¥p ' ji 0.7 rpjdiv

Figure 17: Smoothed vs. unsmoothed traces at high vertical gain.

3.10.5 Sample Depth (DEPTH)

The CT100 sample depth sets the number of sample points per unit time or distance in the live TDR
waveform. In general, higher sample depth sharpens waveforms at larger horizontal scales by increasing
the apparent sampling efficiency of the TDR waveform (the ratio of sampled vs actual change in voltage
from sample to sample). Note that the sample depth of cable scans is set separately (see page 41). The
following TDR waveform sample depth settings are available in the MENU->DEPTH menu option:

1) Classic: Screen resolution (1 sample/pixel). Fastest waveform, lowest resolution, adequate for
many routine cable testing tasks.

2) Cable: Optimal sample depth setting for cable and connector detail (17.5 ps, ~ 0.07 in. / 2 mm).
Stays fixed regardless of screen horizontal scale, ensuring that cable and connector faults are not
missed on long cables due to sample position and or sample depth effects.

3) Fixed: Sets sample depth manually using M-FUNCTION knob, stays fixed regardless of screen
horizontal scale. Useful for enhancing frequency resolution of S;; return loss and cable loss
waveforms which may require sampling at resolutions higher than 17.5 ps.

4) Full Scan: Same as Fixed mode except that full waveform encompassed by screen when Full Scan
mode was entered is always scanned, regardless of horizontal position or scale.

A comparison of the Classic and Cable sample depth settings is shown in Figure 18. Note that the
sampling efficiency discrepancy shown in the figure would resolve at smaller horizontal scales.
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Figure 18: Classic (red) vs. cable (black) sample depth.

3.10.6 Temperature Correction

The CT100 automatically adjusts for changes in ambient temperature. When temperature is displayed on
the screen, a message is also shown giving the status of temperature correction. When the CT2100 is fully
adjusted, the message reads “TC: OK” in green text.

3.11 Test Procedures

3.11.1 Measure Distance-to-Fault (DTF)

1) Attach the cable to the BNC connector.
2) Set Vp to match the Vp of the attached cable.

3) Press and briefly hold the AUTOFIT button before releasing. The CT100 trace is now scaled to show
the entire cable from beginning to end. See Figure 19.

Srmooth 16 1.13B'm
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Figure 19: AUTOFIT cable. The cable termination is an open.

4) Position the active cursor on the reflection caused by the cable fault. Adjusting the vertical scale
helps make cable faults more obvious, as in Figure 20 which is at the same horizontal scale and
zoomed in vertically to show a ~0.8 ohm impedance fault due to the presence of an SMA connector.
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Figure 20: Vertical scale used to emphasize cable fault.

5) Use the HORIZONTAL SCALE and VERTICAL SCALE knobs to further zoom in on the fault to get a
more accurate measurement of Distance-to-Fault (DTF), typically measured from the “toe” or early
rising edge of the fault. The distance measurement to the active cursor is the Distance-to-Fault. See
Figure 21.

¥p 0,700 0.516'm

o, 2.614 ns
' 0,022 Am
0,369 Ans

webExp: BMP,CSY

138 TSR
P RRC -0.16 mp
--------------------------------------------------------- R s I [Tecvie b o
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Figure 21: A zoomed-in view of the cable fault with active (solid)
cursor at the start of the fault (“foe” region) and passive (dashed)
cursor at the peak of the fault.

3.11.2 Relative Distance and DTF Measurements

The CT100 displays the absolute distance from cable start and also the relative distance from the passive
cursor to the active cursor.

Note that Vp must be set accurately for the section of cable between the cursors for the CT100 to measure
relative Distance-to-Fault accurately. The pulse velocity of any part of the cable that is not between the
cursors will not affect the measurement. To measure the relative distance between two points in a cable, do
the following:

1) Move the active cursor to the beginning of the section to be measured.
2) Press the CURSOR button to switch cursors.
3) Move the newly active cursor to the end of the section to be measured.
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4) The CT100 displays the distance measured between the two cursors as a “A” value below the

absolute distance measurement. Figure 22 a three foot segment of 50 ohm cable marked by small
impedance “faults” caused by SMA connectors on both ends.
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Figure 22: Relative distance measurement between two soft
cable “faults” caused by SMA connectors.

In general for the most accurate relative distance or time measurements between two faults, place the
cursors on the “toe” region of the faults where the TDR waveform is just beginning to rise above or below
the cable characteristic impedance.

3.11.3 Multisegment Cable DTF Measurements

Cable assemblies are sometimes made up from different types of cables in series, each of which may be
chosen for unique characteristics such as high-temperature operation or radiation resistance. Such cables
frequently have different velocities of propagation (Vp) making Distance-to-Fault (DTF) measurements
difficult. If the average Vp of the assembly or the Vp of any one cable assembly is used, it will result in
inaccurate distance measurements along the length of the compound cable.

The CT100 includes multi-segment cable measurement capability designed to improved cable
measurement accuracy in the setting of compound, multisegment cables with differing Vp values. The
CT100 allows the operator to break a TDR waveform into cable segments, each of which can have its own
Vp. The distance-to-fault calculated from the compound waveform shows improved accuracy. The
following procedure can be used to perform multisegment cable measurements:

1)
2)
3)

4)
5)
6)

7

Select MENU ->Measurement menu.
Select Cable Segments submenu.

Place the cursor at the position of the cable segment, marked by a connector impedance signature
or other demarcation, such as physical distance as calculated using known Vp for a given cable
segment.

Select Add New Segment
Repeat steps 3 and 4 for each cable segment

Use the Prev Segment and Next Segment selections to select each cable segment and use the M-
FUNC Vp option to set the given segment’s velocity of propagation.\

The Distance-to-Fault measured by the cursor reflects multisegment Vp as shown in Figure 23 and
Figure 24.
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Figure 23: Multisegment cable segment with Vp of 0.400.
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Figure 24: Multisegment cable segment with Vp of 0.850.

3.11.4 Ohms-at-Cursor Measurements

The CT100 also displays the impedance in ohms (Q) at the cursor position. A reading before and after a
reflection from a fault shows the impedance mismatch that could cause such a reflection. Impedance
measurements at the first fault in a cable are more accurate than impedance measurements at more distant
faults.

3.11.5 Scan a Cable

The CT100 can scan and save a trace into memory. CT100 scans differ from traditional TDR waveforms
because they can be used to save detail at a much higher resolution than displayed on the screen. Cable
scans can subsequently be reviewed at different levels of detail and compared to prior scans to identify
subtle changes in cable or connector performance. See Figure 25. Scans may also be referred to as traces
or waveforms in this manual.
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Saved scans can appear on the screen in addition to the live trace. Pressing the Select button switches
between traces. Vertical position and scale are adjusted for individual traces. Changing these values for one
trace won't affect other traces.

To scan a cable or cable segment:

1) Press the SCAN button to bring up the Scan and Trace menu
2) Choose the Scan option from the menu to begin the cable scan.
3) Select the cable scan (see following section Select a Trace) and manipulate as needed.

There are three main types of scans:

1) Screen scans - Capture the live trace as it appears on the screen.

2) Cursor scans - Captures the entire trace between the two cursors at the currently displayed
horizontal resolution.

3) Custom scans - Scans between the cursors using a custom horizontal resolution that can be
configured and saved.

A scanned trace is created with a smoothing factor as set at the time of the scan. Cursor or Custom scans
that cover a long distance at a high resolution may take a long time. During a scan, a menu will appear with
a Cancel option. Select Cancel to immediately abort the scan.
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Figure 25: Scan of a portion of a cable (red), zoomed vertically to show additional
detail relative to the live trace (black).

3.11.6 Select a Trace

The CT100 always shows one trace on the screen in bold. This is the selected trace. VERTICAL POSITION
and VERTICAL SCALE knobs as well as the Save, Delete, and Hide options on the Scan and Trace menu
are all actions that operate on the selected trace, leaving other traces on the screen unchanged. Vertical
measurements such as reflection coefficient, return loss, and impedance are always based off of the
selected trace and may disappear if the cursor scrolls beyond a scanned boundary.

Press the SELECT button to change which trace is active. Figure 26 demonstrates this principle with three
different traces. In Figure 13, screenshots show selection of (A) a live trace, (B) a scanned trace that has
been translated vertically using the VERTICAL POSITION knob, and (C) a trace representing the difference
between the two.
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Figure 26: Worki

3.11.7 Store a Trace

A scanned trace can be stored for later recall:

1)
2)
3)
4)
5)
6)

ng with traces.

Press the SCAN button. The Scan and Trace menu appears.
Press the SELECT button until the saved scan to be stored is selected.

Select the Save option from the

menu.

The CT100 requires a name for storage and will prompt you for one with a dialog box.
A dialog menu appears. Choose the menu option to show the on-screen keyboard.

Use the M-FUNCTION knob and the Keyboard menu to select letters and numbers. See Figure 27.
Also see Navigating dialog boxes on page 14 for more information on using the Keyboard menu.
Press the Select option to enter the highlighted letter into the name. A USB keyboard can also be

used.
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Figure 27: Using the on-screen keyboard.

7) Press the OK option from the menu when finished.

The trace is now stored, and can be recalled later by name under Cable Records.

An FFT trace can also be stored with the same process. However, be sure to select the base trace scan,

not the FFT trace, before storing.

3.11.8 Load a Trace (Cable Records)

Cable records describe configurations used to test individual cables with the CT100. A cable record stores
the Vp, tester configuration, and the scanned trace from a test of an individual cable. Use of cable records
helps ensure that multiple tests of the same cable use the same tester configuration and Vp value. Cable
records do not load calibration values but use the current set values.

A stored trace can be loaded back to the screen:

1) Press the LIBRARY button. The Library menu appears.

2) Select the Cable Records option. An interface appears for the selection of a stored trace.
3) Use the M-FUNCTION knob and the menu keys to select the trace to load.

4) Press the selected menu option to load the trace. The stored trace now appears on the screen. It
can be selected and manipulated the same as any scanned trace. See Figure 28 in which the
loaded trace (bold) has been translated slightly downward using the VERTICAL POSITION knob in

order to improve visualization.
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Figure 28: Loading a trace.

When a previously stored FFT trace is loaded, the FFT trace is automatically re-calculated during loading.
This calculation may take several seconds.
3.11.9 Storing and Transferring Traces

The CT100 has a large storage space, capable of holding thousands of trace scans. However, with
continued use, CT100 storage will eventually fill up. Periodically, an effort should be made to clear stored
traces from the device and free up storage space.

3.11.9.1 Transferring Traces

The CT100 ships with an installation CD for the CT Viewer software for Windows. Using either a USB or an
Ethernet connection, the CT100 can transfer stored scans to CT Viewer. These scans are then stored in the
Windows computer for later retrieval, review, e-mail, and analysis. See Section 4: CT Viewer and/or the CT
Viewer manual for details.

3.11.9.2 Deleting Traces

Once scans are backed up to a computer, they can be deleted from the CT100 either through the CT
Viewer™ software or directly as follows.

1) Press the LIBRARY button to open the Library menu.
2) Select Cable Records. A scroll dialog appears, showing all saved trace scans.
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3) Highlight specific traces for deletion using the Toggle Selected option or select them all with the
Mark All option.

4) Select the Delete option. You will have to confirm the deletion.

3.11.9.3 Freeing Storage Space

Deleting traces is the first step to clearing disk space, but the space is not freed until Clean Database is run.

1) Press the MENU button. The Main menu appears.
2) Select Diagnostics. The Diagnostics menu appears.
3) Select Database. The Database menu appears.

4) Select Clean Database. The CT100 will now free up space that was used by deleted traces. Do not
turn off the CT100 when using clean database.

CAUTION: Switching off power during a clean database could
damage the instrument.

3.11.10 Transient / Intermittent Fault Detection

Not infrequently cable troubleshooting involves detecting and localizing transient or intermittent faults, such
as a twisted pair cable with frayed insulation that briefly shorts its conductors when mechanically disturbed
or a coaxial connector that reflects an open when shaken. The CT100’s Envelope Plot mode simplifies
intermittent fault characterization. To create an Envelope Plot, use the following procedure:

1) Position the TDR trace such that the area of interest is located on the screen at a satisfactory
horizontal and vertical scale. Horizontal and vertical scale cannot be changed in Envelope Plot
mode.

2) Select MENU ->Measurement menu.

3) Select more option.

4) Select Envelope Plot submenu

5) Select Envelope Plot Off to turn Envelope Plot mode on.

6) Toggle between Fill Mode and Probability Density display mode with the Fill Mode On/Off option.

7) The CT100 can monitor a waveform for extended periods of time if appropriate power management
settings are enabled.

8) Sometimes manipulation of the cable and/or connectors of interest during Envelope Plot monitoring
will provoke an intermittent TDR fault.

Fill Mode fills in an area plot between the maximum and minimum impedance values. This is useful to
highlight the location of the fault because the fault typically creates an “arrow” that points to the location of
the fault as shown in Figure 29. Probability Density mode shows the underlying TDR waveforms which can
be useful to determine the fault mechanism and likelihood of occurrence as shown in Figure 30. Both
modes provide the range of impedance values at cursor, as shown in Figure 31.
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Figure 29: Envelope Plot with Fill Mode, active cursor at fault location. Note fault
forms “arrow” pointing to location of a loose connector with impedance variation
caused by mechanical flexion.
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Figure 30: Envelope Plot with Probability Density display.
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Figure 31: Envelope Plot with Fill Mode, active cursor showing range of impedance
values in fault zone (51.5-185.4 ohms).

Note that transient and intermittent faults can also be recorded using the CT Viewer Remote Control feature

as described in Section 4 (page 64).
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3.11.11 Difference (Subtraction) Traces

Difference traces are traces calculated from the subtraction of one waveform from another waveform.
Different traces often allow the operator to identify subtle changes in cable or connector performance. It is
recommended that for any important cable and connector assembly, the as-manufactured or known-good
configuration of the assembly be scanned and archived on the CT100 and/or a host PC running CT Viewer.
Later, these archived traces can be used to create difference traces from current data to highlight changes
in cable assembly impedance. To create a difference trace, use the following procedure:

1) Press the SCAN button. The Scan and Trace menu appears.
2) Press the SELECT button repeatedly until the first trace of interest is selected.

3) Select the Math option from the Scan and Trace menu and choose Set Base. The selected trace is
now a base trace for further Math functions.

4) Press the SELECT button again until the second trace is selected.

5) Select Difference from the Math menu. A new trace is created that displays the difference between
the base trace and the selected trace. See Figure 32 which shows 1.6 ohm excess impedance due
to a slightly loosened SMA barrel adapter. The bold trace is created by subtracting the bottom (live)
trace from the top trace.

Smobth 4 0.547 m
: : 9,124 ns
wehExp: BMP,CSY E oot e Tools
: 1.345 Ans
: 16.76 mp
: 1.50 A%
: RRC 15.28 mp| —raram &
: RRL 26,3 de| Mormalize
§ Tools
Layer
Peeling
: Hide
0.174 m/div DIFF. TRACE 0.4000Wp 5.7 mp/div
B ELVETRACE |  Difference | 1stDerivative | Der. Smooth OFf |

Figure 32: Difference trace. Live (purple), comparison scan (red),
difference (blue) traces show 1.6 ohm excess impedance on the
live trace due to a loosened SMA connector.

3.11.12 First Derivative (Slope) Traces

The CT100 can perform a wide range of mathematical transforms of on-screen traces, both in static and
real-time forms. The first derivative trace is a useful transform. One use of the first derivative trace is to
emulate the waveform of a pulse-type TDR. Another use is to remove the baseline deviation of long or
lossy cables caused by resistive loss, so that vertical gain can be used to emphasize cable faults. To create
a first derivative waveform, use the following procedure.

1) Press the SCAN button. The Scan and Trace menu appears.

2) Press the SELECT button until the trace of interest is selected.

3) Select the Math option from the Scan and Trace menu. The Math menu will appear.

4) Select 1% Derivative from the menu.

5) A new trace is created that displays the first derivative of the base trace. See Figure 33.
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Figure 33: First-derivative trace (yellow).

3.11.13 Second and Higher Order Derivative Traces

The 1 Derivative function can be applied to 1% Derivative traces to create second (and higher) order
derivatives.

3.11.14 Vertical Reference (Vert. Ref.) Calibration

Use the vertical reference (Vert. Ref.) system to increase the accuracy of vertical measurements, including
impedance, reflection coefficient, and return loss. To calibrate with the Vert. Ref. feature, use the following
procedure:

1) From the Main menu, go to the Measurement menu.
2) On the right side, an option for Vert. Ref. appears. Select this. The Vert. Ref. menu appears.

3) Position the active cursor at the left most position where the Vert. Ref. should apply. Typically, this
will be the position where you will apply the open and short attachments in step five. This position
can be changed after the setup.

4) Select the Set Vert. Ref option.

5) A set of terminators, both open and short, are included with the CT2100 for calibration purposes.
Attach these terminators to the CT100 when prompted to do so.

When the reference measurement is finished, cursor measurements will now appear in blue at the right
hand of the screen, and the notification using vert. ref. will appear underneath.

A green line will appear under at the position of the active cursor (see step 3 above). Vertical reference is
applied to all points to the right of the green line. Standard vertical measurements are used for all points to
the left of the green line. The position of this line can be changed with the Vert. Ref Start menu option.

By default, the impedance value at 0 millirho is taken to be 50 Q. This value can be changed with the Vert.
Ref. Center Imp. menu option.

The CT100 is now configured for enhanced accuracy impedance measurements across a wide range of
impedances.

The menu option at the top of the right hand side can be used to toggle the vertical reference on and off as
needed for a given cable length setting.
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3.11.15 Cable Resistive Loss Correction

The CT100 has a system for correcting for resistive loss (“dribble up”) in cables. This allows the operator to
measure impedance more accurately through long and/or lossy cables. Currently resistive cable loss
correction works with Classic sample depth only.

Under the Measurement menu, there is an item to set ohms per unit length and another item to toggle the
correction on and off. The calculations of this feature assume a linear serial resistance to an attached cable
and no other loss. The procedure for performing resistive cable loss correction is as follows:

1) Under MAIN->DEPTH, select Classic sample depth.
2) Select the MAIN->Measurements menu.
3) Select Vertical Correction submenu.

4) Adjust the waveform of interest so that it fits on the screen and position the active cursor to the
right of the waveform you wish to correct.

5) Select Adjust Q/m.

6) Select Q/m Correct On to turn on the correction then press Set O/m Pos. to set the correction
endpoint. The endpoint will appear as a dotted orange vertical line.

7) Rotate the M-FUNCTION knob to change the ohms per unit distance correction setting. Use the
Q/m Correct On toggle menu option to turn the correction on or off.

Changing the Ohms/m setting will change the slope of the cable’s trace as the resistive loss is subtracted,
and consequently the impedance readings for all points on the cable’s trace and beyond. The effect and
accuracy of the ohms per unit length value is dependent on the value for pulse velocity. The effect of
resistive cable loss correction on a relatively lossy nominally 72 ohm RG-59 cable is shown in Figure 34 and
Figure 35.

Use this correction to make more accurate impedance measurements on a length of cable. Since uniform
cables tend to have a characteristic resistive loss per unit length or “dribble up”, one technique is to adjust
the correction until the cable is as flat as possible. Another technique is to attach a known impedance
reference, such as a resistive terminator, to the cable and adjust the ohms per unit length correction until
the measured impedance reads the correct value.
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Figure 34: Resistive cable loss correction, before.
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Figure 35: Resistive cable loss correction, after.

3.11.16 Return Loss (S;;) Waveforms

This feature uses precision open, short, and 50 ohm load (OSL) measurements to correct for systemic
errors in the pulsing and sampling electronics, producing a more accurate S;; result. The procedure for
creating an S;; return loss plot is as follows:

1)

2)
3)
4)
5)
6)

7

8)

Prepare the CT100 by setting the trace resolution as desired. In general a sample depth of 1-2 ps
should be adequate for TDR bandwidth of up to 6.5 GHz. Proportionally larger sample intervals can
be used for lower desired bandwidth. Smaller sample intervals have higher frequency resolution.
Some trial and error may be necessary for a given measurement application.

Use the M-FUNCTION knob to set the smoothing factor to an acceptable level, usually at least 32.
Move the cursors to the beginning and end of the calibration region.

Select the Math menu option to open the Math menu.

Select SParam & Normalized Tools. This will open the SParam & Normalized Tools menu.

Select S;; Calibration. After going through two informational message boxes, the S;; Calibration
menu will appear.

Select Start Calibration. The CT100 will ask in turn for the open, short and 50 ohm terminators.
Afterwards, the S;; trace will appear.

Use the cursors to measure return loss at cursor and average return loss between cursors.

See Figure 36 for an example showing S;; return loss plot of a 200 ohm terminator with average return loss
of 4.7 dB between 1.5 and 3.0 GHz.
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Figure 36: S;; return loss plot of a 200 ohm terminator.

3.11.17 Return Loss (S;;) Between Cursors

The CT100 is able to use time windowing to de-embed features in the time domain waveform for analysis in
the frequency domain using the S;; Between Cursors feature. All other time domain features are excluded
from the analysis so that only the feature of interest is analyzed. Use the following procedure:

1) Create an S;; return loss plot using the procedure as described on page 51.
2) Use the SELECT button to select the TDR waveform.

3) Position the cursors around the feature of interest (e.g. a fault or connector).

4) Select the Between Cursors Off menu option to toggle the S;; Between Cursors feature on. The Sy;
trace will change to reflect just the features in the cursor interval.

See Figures Figure 37-Figure 39 for an example of Sy, return loss plot between cursors. The cursors
bracket an SMA barrel adapter between two 3 ft. segments of coaxial cable. The Si; return loss plot shows
average 35 dB loss across the connector. A loosened connector shows average loss of 29 dB across the
connector, compatible with 6 dB excess return loss.
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Figure 37: S;; between cursors bracketing an SMA barrel adapter on the TDR
waveform.
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Figure 38: S;; between cursors showing average return loss of 35 dB from 1.0-1.9
GHz
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Figure 39: S;; between cursors with connector loosend showing excess 6 dB return
loss.

3.11.18 Cable Loss (Insertion Loss[S,;]) Waveforms

As discussed on page , the CT100 Cable Loss calculation uses a short or open terminator at the remote
end of a cable or other device-under-test (DUT) to measure S,; insertion loss. To create a Cable Loss
waveform use the following procedure:

1)
2)

3)

4)

Create an Sy; return loss plot using the procedure as described on page 51.

Make sure the end of the cable or DUT is terminated with a short (or open if short is not feasible)
and that the termination is included in the S;; calibration region.

Press the Cable Loss Off menu item to toggle the Cable Loss measurement on. The Sy, trace cable
changes to indicate the Cable Loss measurements are being displayed.

When you are finished with Cable Loss measurements, press the Cable Loss On menu item to
toggle the Cable Loss measurement off.

3.11.19 Smith Charts

The Smith chart is a useful graphical tool for plotting reflection coefficients and complex impedance values
and can be used to simplify impedance matching. In-depth discussion of the use of the Smith chart is
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beyond the scope of this document and the reader is referred to the many excellent texts on the topic. The
CT100 allows the operator to display S;; return loss and cable loss waveforms on a Smith chart. To create
a Smith chart, use the following procedure:

1) Create an Sy; return loss plot using the procedure as described on page 51.

2) Select Smith Chart option to toggle Smith chart display.

3) Use the HORIZONTAL POSITION knob to move the cursor along the complex impedance curve.
Figures Figure 40-Figure 43 show Smith chart representations of an open, short, resistive 50 ohm load, and
a reactive 200 ohm load.
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Figure 40: Smith chart representation of open fault.
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Figure 41: Smith chart representation of short fault.
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Figure 42: Smith chart representation of a 50 ohm resistive load.
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Figure 43: Smith chart of reactive 200 ohm load showing effect of reactive
impedance at higher frequencies. Cursor shows impedance value calculated at DC
(0 MHz).

3.11.20 Normalized TDR Traces

This process creates a normalized TDR trace based on an existing calibrated S;; return loss trace. See
page 51. for instructions on creating a calibrated S;; return loss trace.

A normalized TDR trace appears as another live trace in the region of S;; calibration. The normalized trace
should be cleaner than the live trace, with fewer aberrations. The normalized trace also has an adjustable
rise time to help the operator determine what effect a particular cable fault will have on signals with differing
rise times. The following procedure creates a normalized TDR trace:

1)
2)
3)

4)

Create an Sy; return loss plot using the procedure as described on page 51.

From the S-Param & Normalized Tools menu, select Apply Normalization.

Select Normalize Pulse Rise Time and use the M-FUNCTION knob to select a suitable rise time for
the cable system as applicable. Note that selecting a rise significantly shorter than the native rise
time of the TDR instrument will result in a degraded waveform.

Note that the Between Cursors On/Off setting is used by the TDR normalization process. If Between
Cursors mode is turned on, the normalized trace information will be taken from the time-windowed
S;1 waveform.
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Figure 44 shows a normalized TDR trace (blue) with a short fault in a 50 ohm cable. The normalized trace
shows reduced aberrations and more accurate relative reflection coefficient and impedance after the fault
compared with the live TDR trace.
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Figure 44: Normalized trace (blue) showing short fault in a 50 ohm cable.

3.11.21 ZTrace Impedance Traces

The CT100 is able to transform the live TDR waveform so that it is displayed in units of impedance (ohms)
rather than reflection coefficient (millirho) using the ZTrace feature. ZTrace waveforms can be helpful
because they make it possible to visually compare changes in impedance along a TDR trace and some
impedance discontinuities such as opens are easier to identify than on reflection coefficient waveforms. To
create a Z-Trace waveform, use the following procedure:

1) Select MENU ->Measurements menu..
2) Select more menu item

3) Select ZTrace Off to toggle ZTrace transform on.

Example ZTrace waveform is shown in Figure 45. Note vertical scale is in ohms and open fault at the end
of the cable on the red (ZTrace) waveform shows nonlinear relationship of reflection coefficient to
impedance described on page 29.
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Figure 45: ZTrace TDR impedance waveform.
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3.11.22 Layer Peeling (Dynamic Deconvolution) Traces

The CT100 includes the capability to perform layer peeling / dynamic deconvolution. This is a useful
technique for improving impedance accuracy by removing the effects of multiple reflections caused by
impedance discontinuities. In general, any impedance discontinuity creates both forward (transmission) and
backwards (reflection) waves. If reflected off other impedance discontinuities, these reflected waves will
constructively or destructively interfere with the TDR waveform, leading to impedance measurement errors.
The CT100 Layer Peeling feature attempts to iteratively extract the underlying reflection coefficients as
described in Section 3.9. To create a Layer Peeling trace, use the following procedure:

1) Position the TDR waveform on the screen so that the region of interest is visible and that a portion of
50 ohm cable is visible at the left hand of the screen (use the CT100’s internal 50 ohm cable if
needed).

2) Select MENU >Math menu.
3) Select Layer Peeling menu option.

An example of a Layer Peeling trace is shown in Figure 46, which depicts a multisegment cable of varying
impedance. The corrected impedance of the final segment is within 2-3 ohms of the actual value,
approximately 15 ohms better than the uncorrected live TDR trace.
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Figure 46: Example Layer Peeling trace (yellow) versus live TDR trace (white).

3.11.23 Fast Fourier Transform (FFT) Waveforms)

The CT100 can calculate FFT frequency domain information from live and scanned TDR waveforms. FFT
waveforms can be used to show the relative frequency domain content of a waveform or portion of a
waveform between cursors, and comparisons of FFT waveforms can be used to demonstrate differences
and/or changes in frequency content, such as between different types of connectors or cable faults. To
create an FFT trace, use the following procedure:

1) Select the live trace with the SELECT button.

2) Use the CURSOR button and the HORIZONTAL POSITION knob to set the boundaries for the FFT
with a cursor at either end.

3) Press the SCAN button to open the Scan menu.
4) Select the Math menu option to open the Math menu.

5) Select the FFT Tools menu option to open the FFT Tools menu.
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6) Select Apply FFT. The CT100 will now take a high resolution scan of the live trace between the
cursors, then convert the scan into an FFT plot. This may take some time.

FFT traces can be stored and loaded, just like normal scanned traces. When storing an FFT trace, be sure
to select the base scan first, not the FFT trace. When the trace is reloaded, the CT100 will take a few
seconds to recalculate the FFT trace.

3.11.24 Remote Control

Using the accompanying CT Viewer software, the CT100 can be operated by remote control. The remote
control system allows the operator to manipulate traces and store movies of traces over time. Remote
control only functions over Ethernet connections. It does not work when the CT100 is connected by USB
only.

The CT100 must first have a valid IP address in order to use an Ethernet connection. If DHCP is being used
on the network to which the CT100 is attached, the IP address is automatically assigned by your network
administrators. If your CT100 is not connected to a regular network, you will have to manually assign a
“static IP” number using: MENU->Connections—> Network Settings—> Static Network Settings.

To use Remote Control, you will need to connect to the CT Viewer software over Ethernet. On the CT100,
use the MENU->Connections->Add Server menu choice to enter a name and the IP of the remote computer
(server) running the CT Viewer software over Ethernet.

Once the IP address of the remote server is entered, the CT Viewer program will display a popup window
indicating the connection has been established. Then use the Remote Control-> Connect menu item in

CT Viewer to complete the connection. Please consult the CT Viewer manual for details about using remote
control and manipulating a remote TDR trace.

3.11.25 Cable Type Library

The CT100 has a library of common cable types and associated velocities of propagation. Vp for these
cable types can be loaded from the library.

3.11.25.1 Load a Cable Type's Vp

To load a cable type follow this procedure:

1) Press the LIBRARY button. The Library menu appears.

2) Select Cable Type from the menu. An interface appears that allows you to scroll through the cable
types with the M-FUNCTION knob.

3) Select the desired cable type and press OK. Vp is now set to the value for that cable type.

3.11.25.2 User-Editable Cable Types

The CT100 is also able to save and load custom cable types. Use the following procedure to save a
custom cable type:

1) Press the LIBRARY button to access user editable cable types with the menu options Add Custom
Cable Type and Load Custom Cable Type.

2) When Add Custom Cable Type is selected, a window appears for entering a cable type name, a Vp
for velocity of propagation, and an expected characteristic impedance for the cable. When the
window first appears, Vp will be set to the current system Vp, while impedance defaults to 50 ohms.
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The other menu option, Load Custom Cable Type, opens a window with all of the added user types
available for selection. Use the M-FUNCTION knob and the Select menu option to load a particular cable
type. When selected, the operating Vp is changed to match the selected cable type.

The user-added cable types are stored and accessed separately from the standard cable types, which are
still available through the Cable Types menu item.

3.11.26 Other Measurement Settings

3.11.26.1 Change Units
Horizontal measurements can be displayed in physical meters, centimeters, feet, inches, or yards.

1) If there is a menu on the screen, press the MENU button until no menu is on the screen.

2) Press the MENU button. The screen will display the Main menu.

3) Select Measurement from the menu. The Measurement Settings menu appears.

4) Select Units to switch between the different unit options.
All measurements and all traces are immediately updated to reflect the unit change. Nanoseconds are
displayed separately.
3.11.26.2 Fine Vp Control

By default, the CT100 displays three decimal places for Vp; however, the CT100 can display six decimal
places for Vp when extremely precise distance measurements are desired.

1) If there is a menu on the screen, press the MENU button until the menu disappears.
2) Press the MENU button. The screen will display the Main menu.
3) Select Measurement from the menu. The Measurement Settings menu appears.

4) Select Vp 3/6 Sig Figs from the menu. The CT100 will now display 6 decimal places for the Vp
readout on the screen when Vp 6 Sig Figs is shown on the menu.

5) When the CT100 is in Fine Vp mode, a new function, Fine Vp, is added to the M-FUNCTION knob.
When the M-FUNCTION knob is set to Fine Vp, turning the knob will change the Vp value by the
millionths. The Vp value can be changed by thousandths as normal by setting the M-FUNCTION
knob to the Coarse Vp function.

3.11.26.3 Relative Reflection Coefficient (RRC) Method

The CT100 measures the relative reflection coefficient between cursors. When the two cursors of the
CT100 are positioned on either side of a change in impedance, this measurement is the reflection
coefficient for that change. By default, the value is displayed in Classic mode, displaying the true reflection
coefficient relative to the signal at the input of the reflection. The CT100 can also measure in 1502C mode,
which displays a reflection coefficient relative to the signal at the input of the cable.

1) If there is a menu on the screen, press the MENU button until the menu disappears.
2) Press the MENU button. The screen will display the Main menu.
3) Select Measurement from the menu. The Measurement Settings menu appears.

4) Select RRC Method from the menu. This will toggle the CT100 between the Classic RRC calculation
and the 1502C calculation as displayed on the screen.
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3.11.27 User Configurations

The CT100 allows the user to save configurations with a name. A saved configuration stores the values of
all CT100 settings. A configuration can be called up by its name, restoring all settings to the values saved in
that configuration. By default, the configuration load screen is displayed at start up for easy loading of
configurations.

User Configurations can reduce operator error when configuring the TDR to make important measurements.
For this reason it is recommended that User Configurations be used when setting up the CT100 for
important measurements, such as quality-control checks on a cable manufacturing line.

3.11.27.1 Save Configurations

1) Press the LIBRARY button. The Library menu appears.

2) Select the Save Config item. The CT100 will prompt you for a configuration name, then saves the
configuration. See Navigating dialog boxes on page 14 for information on using the Keyboard menu.

3.11.27.2 Load Configurations

1) Press the LIBRARY button. The Library menu appears.
2) Select the Configurations menu item. The Configurations dialog box appears.
3) An interface that lets you scroll through the configurations with the M-FUNCTION knob is displayed.

4) Press OK on the menu when the appropriate configuration is highlighted. All settings saved in that
configuration are automatically restored. Measurements and traces are updated to reflect the new
settings.
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4 CT Viewer™

The CT Viewer host computer software allows users of the MOHR CT100 and CT100HF Metallic Time-
Domain Reflectometer (TDR) to transfer, view, and manipulate the cable scans that have been saved on
their instruments. This software package allows the user to select scans from a stored database that can
contain thousands of scans and compare, subtract, or find the first derivative of any of the traces.

This software package will also allow the user to create reports and print plots that can be imported into MS
Word or other word processing or report creation software to create files of traces suitable for transfer to
others and to load trace files created by others.

This section covers how to transfer saved TDR traces to CT Viewer. For more detailed information on
installing and using CT Viewer, please see the CT Viewer manual.

4.1 Sending Saved Traces to a Computer

When a scanned trace is saved to the CT100, it can be sent to a computer that has CT Viewer installed.

4.1.1 Send Saved Traces with a Thumb Drive

1) Insert a thumb drive into a USB port on the front of the CT100. Wait until the thumb drive icon
appears on screen.

2) Press the LIBRARY button to bring up the Library menu.

3) Choose the Cable Records menu option. A window listing all of the traces saved to the CT100
appears.

4) Use the M-FUNCTION knob to select a trace to send to the thumb drive.

5) Choose USB save from the menu. The select trace will now be written to the thumb drive. More
than one trace can be added to a thumb drive by selecting different traces and choosing USB save
from the menu.

6) Insert the thumb drive into a USB port on the computer.
7) Start CT Viewer.
8) From the File menu in CT Viewer, select Load from File.

9) Select “scans.ztp” from the thumb drive. The trace will be loaded into CT Viewer and shown on the
screen.

4.1.2 Send Saved Traces over USB

4.1.2.1 Setup USB Drivers on the Host Computer

The USB drivers need to be set up only once for each computer. The USB drivers for the CT100 should
have been installed with CT Viewer™. |t is possible to skip this step during the installation. If the drivers
aren’t installed, Windows will pop up a message saying so when the CT100 is connected over USB.
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4.1.2.2 Send the Traces

1) Start CT Viewer.

2) Connect the computer to the CT100 with a standard USB printer cable. Connect to the USB port on
the back of the CT100.

3) Go the File menu in CT Viewer and select Open Tester. A screen will appear that will show the
serial number of the connected CT100 and a list of all traces saved on the CT100.

4) Select a trace to transfer by clicking with the mouse. Select multiple traces by holding down the
shift or ctrl key while clicking with the mouse

5) Select the TRANSFER TO button to send the traces to CT Viewer. The traces will also be shown
on the screen.

4.1.3 Send Saved Traces and Use Remote Control with Ethernet

4.1.3.1 Setup Ethernet

In order to send traces over Ethernet to a computer, both the computer and the CT100 need to be setup for
the network. Depending on the how your network is configured, the default settings for the CT100 may
work. If they do not work, network settings should be setup by a network administrator for both the CT100
and the computer.

The CT100 settings can be found from the main menu in Connections -> Network Settings. The CT100
can get a configuration through DHCP, or it can be manually setup with the Static Network Settings.

4.1.3.2 Connect to CT Viewer

1) Make sure both the computer and the CT100 are plugged into the network. The CT100 Ethernet
plug is found on the back of the CT100. Check that the indicator light on the CT100 Ethernet port is
glowing.

2) Start CT Viewer on the computer.

3) Go to the main menu on the CT100. Select Connections.

4.1.3.3 Connecting for the First Time

1) From the Connections menu, Select Add Server. A window with various server settings appears.

2) Use the M-FUNCTION knob to move up and down in the window. Use the on screen keyboard or a
USB keyboard to enter values. In Server Name, enter a user friendly name for the computer.

3) In Server Address, enter either a network name, or an IP address for the computer.

4) Do not change the port number.

5) Press OK. The CT100 will try to connect to the server. If it succeeds, a message will appear in
CT Viewer.
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Figure 47: Add Server window.

4.1.3.4 Connecting After the First Time

1) From the Connections menu, select Server Select. A window showing all the stored server
connections will appear.

2) Use the M-FUNCTION knob to highlight the connection for the computer.

3) Press SELECT. The CT100 will try to connect to the server. If it succeeds, a message will appear

in CT Viewer.
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[ | Delete [ Select | Cancel | |

Figure 48: Select Server window.

4.1.3.5 After Connecting

1) Go the File menu in CT Viewer and select Open Tester. A screen will appear that will show the
serial number of the connected CT100 and a list of all traces saved on the CT100.

2) Select a trace to transfer by clicking with the mouse. Select multiple traces by holding down the
shift or ctrl key while clicking with the mouse
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3) Select the TRANSFER TO button to send the traces to CT Viewer™. The traces will also be shown
on the screen.

4.1.4 Use Remote Control

After the CT100 has connected to a computer over Ethernet using the previous steps, in CT Viewer Select
Remote Control->Connect.

Once Remote Control has been established, a new, live trace will appear in CT Viewer. This trace will be
identical to the trace on the CT100 screen. It can be moved around or scaled just like any other trace in
CT Viewer.

Normally the CT100 screen goes blank during remote control. To turn on the CT100 screen at the same
time as Remote Control, select Remote Control->Assist Mode in CT Viewer.

4.1.5 Record and Playback Real-Time TDR Waveform Movies

CT Viewer can record a real-time movie of the TDR waveform, useful for detecting and characterizing
transient / intermittent faults. To record a real-time movie of the CT100 waveform, select Remote Control->
Record to File. You will be prompted to enter a filename for the recording. Select Stop to stop the
recording. To view the individual TDR waveforms saved in the movie, select the movie file and use the >
and < keys to step forward and backward in the file. The time stamp of the trace is shown as part of the
trace label.
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5 Options and Accessories

5.1 Options

Model CT100 -- standard pulser-sampler with self-grounding BNC test port
Model CT100S -- standard pulser-sampler with stainless-steel SMA test port
Model CT100HF -- high-frequency pulser-sampler with stainless-steel SMA test port

5.2 Accessories

5.2.1 Standard BNC Accessories (CT100)

BNC 50 ohm 36” Test Cable

BNC 50 ohm Precision Terminator

BNC Capacitive Calibrator

BNC Female to Female Adapter

BNC Male to Male Adapter

BNC Shorting Cap

External Charger/Power Supply TRG70A240-11E13
Operator's Manual, Printed

CT Viewer™ Manual, Printed

CT Viewer™ |nstallation CD, w/ Digital Operators
and CT Viewer™ Manuals

Soft Carrying Case
NIST-Traceable Calibration with Certificate

5.2.2 Standard SMA Accessories (CT100S, CT100HF)

SMA 50 Ohm 36” Test Cable

SMA 50 ohm Terminator

BNC Capacitive Calibrator

SMA Male to Male Adapter

BNC Male to Male Adapter
Connector, SMA male to BNC female
Connector, BNC male to SMA female
SMA Shorting Cap

24 VDC External Power Supply TRG70A240-11E13
Operator's Manual, Printed

CT Viewer™ Manual, Printed

CT100-AC-W536B
CT100-AC-ER50
CT100-AC-C001
CT100-AC-IBFF
CT100-AC-IBMM
CT100-AC-IBS
CT100-AC-PS
CT100-M-OM-xxx*
CT100-M-CTVM-xxx*

CT100-S-CTVOM-xxx*

CT100-AC-CS
CT100-AC-NISTCC

CT100-AC-W536S
CT100-AC-ER50-S
CT100-AC-C001
CT100-AC-ISMM
CT100-AC-IBMM
CT100-AC-ISMBF
CT100-AC-IBMSF
CT100-AC-ISS
CT100-AC-PS
CT100-M-OM-xxx*
CT100-M-CTVM-xxx*
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CT Viewer™ |nstallation CD, w/ Digital Operators

and CT Viewer™ Manuals
Soft Carrying Case

NIST-Traceable Calibration with Certificate

CT100-S-CTVOM-xxx*
CT100-AC-CS
CT100-AC-NISTCC

5.2.3 Optional accessories (CT100/ CT100S / CT100HF)

24 VDC lIsolated External Power Supply CT100-AC-PSI

Hard Carrying Case (Pelican) CT100-AC-CH
Connector, BNC female to Dual Banana Plug CT100-AC-IBFDBAP
Connector, BNC male to Dual Binding Post CT100-AC-IBMDBIP
Connector, BNC female to Hook-tip Leads CT100-AC-IBFL

Connector, BNC male to N female
Connector, BNC female to N male
Connector, BNC female to UHF male
Connector, BNC female to UHF female
Connector, BNC female to Type F male
Connector, BNC male to Type F female
Adapter 50 Ohm to 75 ohm

Adapter 50 Ohm to 93 ohm

Adapter 50 Ohm to 125 ohm

Small Form Factor CE Keyboard

Clear Screen Protector Pack
Anti-Glare Screen Protector Pack

BNC Adapter Kit

SMA Adapter Kit

CT100-AC-IBMNF
CT100-AC-IBFNM
CT100-AC-IBFUHFM
CT100-AC-IBFUHFF
CT100-AC-IBFFM
CT100-AC-IBMFF
CT100-AC-I5075
CT100-AC-15093
CT100-AC-150125
CT100-AC-KBD
CT100-AC-SPC
CT100-AC-SPAG
CT100-AK-BNC
CT100-AK-SMA

Impedance Matching Kit 75,93,125 ohm (BNC) CT100-IK-BNC
Impedance Matching Kit 75,93,125 ohm (SMA) CT100-IK-SMA
Impedance Matching Adapter, 50 to 75 ohm (BNC) CT100-AC-I5075-BNC
Impedance Matching Adapter, 50 to 93 ohm (BNC) CT100-AC-I5093-BNC
Impedance Matching Adapter, 50 to 125 ohm (BNC) CT100-AC-I50125-BNC
Impedance Matching Adapter, 50 to 75 ohm (SMA) CT100-AC-I5075-SMA
Impedance Matching Adapter, 50 to 93 ohm (SMA) CT100-AC-I5093-SMA
Impedance Matching Adapter, 50 to 125 ohm (SMA) CT100-AC-I50125-SMA

5.2.4 Service accessories (CT100/ CT100S / CT100HF)

Technical Manual, Printed CT100-M-TSM-xxx*
Technical Manual, Digital w/ CT Viewer™ Installation CT100-S-CTVTSM-xxx*

* xxx applies to revision number. Accessory part number is incremented per revision.
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Appendix A: Specifications

1.1 Electrical Specifications

Characteristic

Specification

Notes

Reflected rise time, CT100 10-90%

150 ps typ, 200 ps max

10 to 90%, into 50 ohms

Reflected rise time, CT100 20-80%

100 ps typ, 150 ps max

20 to 80%, into 50 ohms

Reflected rise time, CT100HF 10-90%

100 ps typ, 130 ps max

10 to 90%, into 50 ohms

Reflected rise time, CT100HF 20-80%

60 ps typ, 90 ps max

20 to 80%, into 50 ohms

Jitter 15 ps max (peak-to-peak) <1 ps rms typ.
Output impedance 50 Q +2%
Pulse amplitude 300 £10 mV Averaged value into 50 ohms

Pulse width

Fixed: 1.000-2.000,5.000-6.000,20.00-
21.00 ps

Averaged values change for
short, medium, and long cable
length settings, respectively

Pulse repetition time

Fixed: 4.00040.002, 20.0040.02,
80.00+0.02 ps

Averaged values change for
short, medium, and long cable
length settings, respectively

Sequential sampling rate

Fixed: 250.0+0.2, 50.00+0.04,
12.504+0.02 kHz

Averaged values change for
short, medium, and long cable
length settings, respectively

Vertical scale

0.5 mp/div

Vertical accuracy

+3% full scale

Vertical position

Any trace point is movable to the center
of the screen.

Sampling efficiency, CT100

50 to 90%

into 50 ohms

Sampling efficiency, CT100HF

45 to 90%

into 50 ohms

Noise

+5 mp peak-to-peak

Input susceptibility

1A

Into diode clamps

Distance cursor resolution

1/45 of one major division

Cursor readout range

<-0.3m (-1 ft.) to > 10000 m (33000 ft.)

Cursor readout resolution

0.0002 m (0.0007 ft.)

Distance measurement accuracy

<1cm (0.3in.) or +0.5% of
measurement plus uncertainty in Vp,
whichever is greater
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Characteristic

Specification

Notes

Impedance readout range

<1 Qto>1.5kQ

Impedance resolution

3 significant digits

Impedance accuracy

+10%, relative measurement 2%

< 1% or 1 ohm typ.

Horizontal scale

0.01 m/div (0.03 ft/div) to = 61 m/div
(200 ft/div) (variable with pulse width)

Horizontal range

<0 mto > 1000 m (3300+ ft)

Horizontal position

Any distance to full scale can be moved
on the screen.

Vp range 0.250000 to 1.000000

Vp default resolution 0.001

Vp fine resolution 0.000001

Vp default accuracy +0.1%

Vp fine accuracy +0.0001%

USB host port UsB 1.1 Front USB host connector is
powered (500 mA limit) with
500 VDC isolation from test port.

USB client port UsB 1.1 500 VDC isolation from test port.

Ethernet port

The instrument includes a 10/100mbps
Ethernet port for network
communication.

500 VDC isolation from test port.

DC power supply

24 VVDC, 2.5A, positive tip. Use only the
MOHR-approved power supply.

500 VDC isolation from test port.

Battery pack

12 NiMH AA cells, fused at 2.5 A

Pack may wear out over time.

Battery operation time

> 6 hours. Power save options may
extend operating time.

18V full charge down to 12 V
battery low, 35% duty cycle.

Battery charge time

2.5 hours from fully discharged state

Overcharge protection

Charging discontinues once full charge
is attained.

Discharge protection

Instrument turns off prior to battery
damage

Software shutdown when battery
is low.

Charge capacity

2.7 Amp-hours (nominal-new)
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1.2 Environmental Specifications

1.2.1 Temperature

Operating temperature 0°C to +50°C
Non-operating temperature -20°C to +60°C

1.3 Mechanical Specifications

1.3.1 Weight
Without cover 2150 g (4.740 1b.)
With cover 2323 g (5.121 1b.)

1.3.2 Dimensions

Height 10.9cm (4.28in.)
Width w/ handle 29.2cm (11.50in.)
Width w/o handle 26.2 cm (10.301in.)
Depth w/ cover 17.5cm (6.90in.)
Depth, handle extended 27.9cm (11.00in.)

1.4 Certifications and Compliances

1.4.1 EC
The CT100 and CT100HF comply with all applicable EU directives.

1.4.2 FCC Compliance

CT100 and CT100HF emissions comply with FCC Code of Federal Regulations 47, Part 15, Subpart B,
Class A Limits.
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Appendix B: Operator Performance Checks

1.1 General Information

The CT100 and CT100HF Operator Performance Check is a series of procedures used to verify the
calibration of a CT100 or CT100HF unit. The following series of checks should be performed after a unit
has been newly calibrated to verify compliance to published specifications, but may also be performed to
determine if it requires recalibration. Calibration procedures are provided in the CT100 Technical Service
Manual Appendix F.

The following series of steps are designed to allow a CT100 operator to completely verify the properties of
an individual CT100 unit to each published specification.

NOTE: If a CT100 fails any Operator Performance Check, it should be
serviced.

1.2 Required Equipment

Iltem MOHR part number

50 ohm precision terminator CT100-AC-ER50 (for CT100)
CT100-AC-ER50S (for CT100HF)

Capacitive calibrator CT100-AC-C001

Connector, SMA male to BNC female CT100-AC-ISMBF (for CT100HF)

Shorting cap CT100-AC-IBS (for CT100)
CT100-AC-ISS (for CT100HF)

36-inch calibration cable CT100-AC-W536 (for CT100)
CT100-AC-W536S (for CT100HF)

Male-male BNC connector CT100-AC-IBMM (for CT100)

Additionally, a device capable of taking accurate pulse measurements with documented calibration will be
required, and, if working with a CT100, an open will be needed.

1.3 Getting Ready

Disconnect any cables from the front BNC or SMA connector. Connect the instrument to a suitable power
source, either a fully charged battery or the external 24V power supply connected to a standard 3-prong
AC source.
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1.4 Operator Performance Checks

1.4.1 Jitter, Noise, Rise Time, and Sampling Efficiency Checks

1) Connect a 50 ohm terminator to the CT100 front panel cable connector.

2) From the Main menu, select the Diagnostics menu item to enter the Diagnostics submenu.

3) Select Jitter. After a moment, a results window appears with a list of measurements.

The value for Jitter used in the specification for a CT100 is Jitter P2P. The value for Noise is the Noise
P2P.

The value for the 20-80% and 10-90% Reflected Rise Times are both displayed as 20-80 Rise and
10-90 Rise, respectively.

1.4.2 Output Impedance Check

1) Disconnect any cables from the CT100 front panel cable connector.
2) Position a cursor before the falling edge of the trace.

3) Position the second cursor well beyond the falling edge.

4) Attach a precision 50 ohm terminator to the CT100.

5) The difference in ohms between the two cursors is a measure of the deviation of output impedance
from 50 ohms.

1.4.3 Pulse Amplitude Check

Pulse amplitude measurement should be taken with a device that can accurately measure frequency, pulse
width, period, and amplitude.

Connect one end of the 36 in. calibration cable to a capable pulse measurement device and the other end
of the 36 in. calibration cable to the CT100 front panel cable connector. A waveform should appear on the
device display. Switch the CT100 into the short pulse setting from the Main menu. Measure the pulse
amplitude coming off the front panel cable connector. The averaged pulse amplitude into 50 ohms should
be between 290 mV and 310 mV.

Repeat pulse amplitude comparison for medium and long pulse settings.

1.4.4 Pulse Width Check

Pulse width measurement should be taken with a device that can accurately measure frequency, pulse
width, period, and amplitude.

Connect one end of the 36 in. calibration cable to a capable pulse measurement device and the other end
of the 36 in. calibration cable to the CT100 front panel cable connector. A waveform should appear on the
device display. Switch the CT100 into the short pulse setting from the Main menu. Measure the pulse width
coming off the front panel cable connector. The average pulse width should be between 1.000-2.000 psec
for short, 5.000-6.000 psec for medium, and 20.00-21.00 psec for long.
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1.4.5 Pulse Repetition Period Check

Pulse repetition rate measurement should be taken with a device that can accurately measure frequency,
pulse width, period, and amplitude.

Connect one end of the 36 in. calibration cable to a capable pulse measurement device and the other end
of the 36 in. calibration cable to the CT100 front panel cable connector. A waveform should appear on the
device display. Switch the CT100 into the short pulse setting from the Main menu. Measure the pulse
repetition rate coming off the front panel cable connector. The average pulse repetition rate should be
4.00040.002 pusec for short, 20.00+0.02 psec for medium, and 80.00+0.02 psec for long.

1.4.6 Pulse Frequency Check

Pulse frequency measurement should be taken with a device that can accurately measure frequency, pulse
width, period, and amplitude.

Connect one end of the 36 in. calibration cable to a capable pulse measurement device and the other end
of the 36 in. calibration cable to the CT100 front panel cable connector. A waveform should appear on the
device display. Switch the CT100 into the short pulse setting from the Main menu. Measure the pulse
frequency coming off the front panel cable connector. Repeat pulse frequency measurements for short,
medium, and long pulse settings. The averaged pulse frequency should be 250.0+0.2 kHz for short,
50.00+0.04 kHz for medium, and 12.50+0.02 kHz for long.

1.4.7 Sequential Sampling Rate Check

The sequential sampling rate is the reciprocal of the pulse repetition time.

1.4.8 Vertical Scale Check

Twist the VERTICAL SCALE knob clockwise. Vertical scale should drop to 0.5 millirho/div and the trace
should expand accordingly.

1.4.9 Vertical Accuracy Check (millirho)

1) Attach an open to the CT100.
2) Paosition a cursor on the trace so that it is well after the open.
3) The vertical measurement should be between 940 millirho and 1060 millirho.

1.4.10 Vertical Position Check

1) Increase vertical scale to 500mp/div by turning the VERTICAL SCALE knob counter-clockwise.

2) Use the VERTICAL POSITION knob to move the live trace completely above the horizontal midline
of the screen.

3) Use the VERTICAL POSITION knob to move the live trace completely below the horizontal midline
of the screen.

A CT100 must succeed at both operations to pass the Vertical Position Check.
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1.4.11 Distance Cursor Resolution Check

Distance cursor resolution is a value determined by a constant. It can be measured by counting distinct
locations that a cursor may occupy between two division lines, including one of the division lines.

1.4.12 Cursor Readout Range Check

In the Measurement menu, set the cable length to “extra long.”

Turn the HORIZONTAL SCALE knob counter-clockwise until horizontal scale is maximized.
Using the M-FUNC button and M-FUNCTION knob, set Vp to 1.000.

With the HORIZONTAL SCALE knob, position a cursor at the most far right position possible.

The absolute distance measurement for the cursor is the upper limit for cursor readout range. This number
should be larger than 10,000 m or 33,000 ft.

Position a cursor at the most far left position.

The absolute distance measurement for the cursor is the lower limit for cursor readout range. This number
should be less than -1 ft. (-0.3 m).

1.4.13 Cursor Readout Resolution Check
Use the HORIZONTAL SCALE knob to set the horizontal scale to 0.00330 ft./div or 0.001 m/div.

Position a cursor on the screen and note the absolute distance measurement for the cursor.

Move the cursor the smallest possible step using the HORIZONTAL POSITION knob. The difference
between the new distance measurement and the previous is the minimum cursor readout resolution.

1.4.14 Distance Measurement Accuracy Check

Accuracy is determined by taking a cable of known length and velocity and comparing the known values
against measured values. Accuracy is reported as a percentage. When determining accuracy, ensure that
horizontal calibration has been performed accurately.

Accuracy should be checked for short, medium, and long pulse settings.

1.4.15 Ohm Readout Range Check
Connect the 36 in. calibration cable to the CT100.

Position a cursor on the trace well beyond the end of the cable. The vertical impedance measurement
should read = 1.5k ohm.

Position a cursor on the trace well before the leading edge of the pulse. The vertical impedance
measurement should read < 1 ohm.
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1.4.16 Resolution Check

Position a cursor at a point of the trace where the vertical impedance measurement is greater than 1 ohm
and less than 1500 ohms. The CT100 should display 3 digits for this measurement.

1.4.17 Vertical Accuracy Check (ohms)

Vertical accuracy is checked by comparing CT100 resistance (impedance) measurements against a known
value. The supplied 50 ohm terminator is required.

To view vertical accuracy, the impedance at cursor must be displayed. Enable impedance at cursor
readings from within the Display submenu.

To determine vertical accuracy, connect a 50 ohm terminator onto the front panel cable connector. Move a
cursor out to a length greater than 300 ns. Impedance may change a small amount from point to point.
Average impedance amongst a number of points along the trace determines vertical accuracy.

Impedance at cursor should be between 45 and 55 ohms.

Vertical accuracy should be checked for short, medium, and long maximum cable lengths.

1.4.18 Horizontal Scale Check
From the Main menu, set CABLE LEN to “Long.”

Using the M-FUNC button and M-FUNCTION knob, set Vp to 1.00.

Turn the HORIZONTAL SCALE knob counter clockwise. Harizontal scale should increase beyond 61 m/div
or 200 ft./div.

Turn the HORIZONTAL SCALE knob clockwise. Horizontal scale should decrease below 0.01 m/div or
0.03 ft./div.

1.4.19 Horizontal Range Check

See the cursor readout range instructions above. Horizontal range and cursor readout range are always
equal.

1.4.20 Horizontal Position Check

This test is passed implicitly when the Cursor Readout Range and Horizontal Range checks are passed.
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1.1 General Information

Use this troubleshooting guide when there is a problem with a CT100 or to assist with problem
identification. This will help you to determine if the instrument should be repaired or is acceptable to
continue using.

Any time one of the internal thermal fuses actuates with an audible click, indicating thermal overload, turn
off the rear panel battery-disconnect switch immediately and have the instrument serviced as soon as
possible.

CAUTION: DO NOT continue using the CT100 if it exhibits signs of thermal
overload, such as emitting heat or smoke, or if it smells of burning plastic.

1.2 Power On Test

Verify that the back switch is in the ON position. Press the red front button to turn the instrument on. If the
instrument does not show anything on the screen within 20 seconds, turn the back switch to the OFF
position, unplug all USB and Ethernet devices, and attempt to turn it on again.

1.3 Functional Block Diagram and Troubleshooting Flowcharts

Use the following functional block diagram and troubleshooting flowcharts for various parts of the CT100 to
determine if your CT100 requires service.
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CT100 Functional Block Diagram
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Appendix D: Maintenance and Service Instructions

1.1 Cleaning and Lubrication

Clean the CT100 with a damp cloth. Clean the LCD screen with LCD screen cleaner or optical lens
cleaner. Do not use any powerful solvents when cleaning the CT100. The CT100 does not require
lubrication.

1.2 Cleaning and Lubrication Interval

Clean once per week, or as necessary.

1.3 Battery Removal / Replacement

1) Ensure that the CT100 power is off.

2) Remove all external devices and power connections from the instrument.

3) Apply the front cover (part CT292) and lay the instrument face down on a smooth surface.
4) Remove the two cross-top screws from the rear of the instrument.

5) Swing the handle to the back of the instrument.

6) Using a long handled cross-top screwdriver, remove the two pairs of screws from both ends of the
instrument nearest the handle mounts.

7) Carefully remove the rear housing (CT291) from the front panel (CT290), using the handle for gripping.
The housing may be tight and the rubber feet may momentarily catch while they slide past the metal
frame.

8) The battery pack should now be exposed at the lower-rear of the instrument.

9) Unclip the 3-pin battery connector by pressing on the release tab and pulling on the connector housing.
10) Remove the two cross-top screws mounting the battery clips (part CT112) to the chassis.

11) Lift the battery pack out.

To re-install or replace the battery, undo the above steps in reverse order.

1.4 Calibration and Calibration Interval

The recommended calibration interval is 2 years. See Appendix B for instructions on how to determine if
your instrument should be calibrated between scheduled calibrations. Detailed calibration procedure is
found in the Technical Manual Appendix F.

CT100/ CT100S / CT100HF Operator's Manual 89






Appendix E: Vp of Common Cables

1.1 Cable Types

Commonly encountered cable designations, along with their associated characteristic impedances and
typical Vp values, are listed below. A more complete listing is stored in the CT100's internal memory.

Note that the actual Vp of a given cable can vary by manufacturer, manufactured lot, cable age and
condition, whether it is flat or coiled on a roll, and other variables. The most accurate way to test a cable is
to determine the Vp of the cable using the CT100 and a known length of the cable you wish to test. See
Operating Instructions > Test preparations > Find an unknown Vp for more information on determining the

Vp of a cable.

1.2 Dielectric Material

Type

Jelly-filled
Polyethylene
PTFE/ TFE

Pulp

Foam / cellular PE
Semisolid PE

Air

Zo(Ohms)

Probable Vp
0.64
0.66
0.70
0.72
0.78
0.84
0.98
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Appendix E: Vp of Common Cables

1.3 RG Standards

Designation
RG-6/U
RG-6/UQ
RG-8/U
RG-9/U
RG-11/U
RG-58/U
RG-59/U
RG-62/U
RG-62A
RG-174/U
RG-178/U
RG-179/U
RG-213/U
RG-214
RG-218
RG-223
RG-316/U
RG-393

Zo,(ohms) Vp

75
75
50
51
75
50
75
92
93
50
50
75
50
50
50
50
50
50

0.66
0.66
0.66
0.66
0.66
0.66
0.66
0.84
0.84
0.84
0.69
0.67
0.66
0.66
0.66
0.66
0.66
0.66
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1.4 MIL-C-17 Standards

Designation Zy,(ohms) Vp

M17/2-RG6 (RG-6/U) 75 0.66
M17/163-00001 (RG-8/U) 50 0.66
M17/6-RG11 (RG-11/U) 75 0.66
M17/155-00001 (RG-58/U) 50 0.66
M17/29-59 (RG-59/U) 75 0.66
M17/173-00001 (RG-174/U) 50 0.84
M17/169-00001 (RG-178/U) 50 0.69
M17/094-RG179 (RG-179/U) 75 0.67
M17/172-00001 (RG-316/V) 50 0.66
M17/127-RG393 (RG-393/U) 50 0.66

1.5 Commercial Designations

Designation Zo(ohms) Vp

H155 50 0.79
H500 50 0.82
LMR-200 50 0.83
HDF-200 50 0.83
CFD-200 50 0.83
LMR-400 50 0.85
HDF-400 50 0.85
CFD-400 50 0.85
LMR-600 50 0.87
LMR-900 50 0.87
LMR-1200 50 0.88
LMR-1700 50 0.89
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1.6 Twisted Pair

Designation
CAT5
CAT6

Zy (ohms) Vp

100
100

0.71
0.71
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Glossary

Aberrations

Imperfections or undesired variations in a signal. For example, aberrations in a TDR's excitation signal are
the result of the finite switching speed of the instrument's electronics and cause it to deviate from a perfect
step signal.

AC

Alternating current, a method of delivering electrical energy by periodically changing the direction of the
electric field in a conductor.

Accuracy

The difference between a measured or estimated value of a quantity and its true value. Accuracy and
precision are both important factors to consider when assessing the reliability of a measurement.

Analog

Refers to a signal that is continuous with respect to both time and value. Analog circuitry produces and/or
measures analog signals. This is in contradistinction to digital signals, which are discontinuous in both time
and value. The sampling circuitry of a TDR converts the analog voltage signal detected on a cable to a
digital value for representation on the display and in the instrument's memory.

Cable

Conductors of electricity that are usually shielded and insulated. Cables typically contain at least two
conductors, one to deliver the electrical signal and one to act as the return path. The conductor acting as
the return path may be referred to as the “shield,” “ground,” or “ground wire.” A cable with such a ground
return path is known as an unbalanced cable, an example of which is typical coaxial cable. Another general
type of cable is called balanced cable, an example of which is twisted pair Ethernet cable. In balanced
cable, two signal wires carrying differential signals of opposite polarity are both separated from ground by
an equal impedance.

Cable Attenuation

A quantity describing the energy in a signal that is absorbed, reflected, or otherwise lost during propagation
through a cable. Higher frequencies are typically the most susceptible to attenuation. Cable attenuation can
distort some TDR measurements. Attenuation is often expressed in decibels (dB) at one or more
frequencies. See also dB and Return Loss.

Cable Fault

A defect in a cable or other condition that makes a cable less able to deliver electrical energy than was
designed. Damage to the shield, conductor, or insulation, bad splices, and poorly mated connectors are
frequently encountered cable faults.

Capacitance
See Reactance.
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Characteristic Impedance

The ratio of the amplitude of voltage and current in an electrical signal propagating in a cable. In a coaxial
cable, this value (usually written Zo) is, in large part, related to the geometrical relationship of conductor to
return path conductor. Cables are usually designed to match the impedance of the source and load to
which they are attached in order to maximize power transfer.

Conductor

A substance that allows electricity to flow through it with minimal resistance. Most conductors are metals.
However, there are many non-metallic conductors, including salt solutions, graphite, and any element in its
plasma state.

dB

dB is the abbreviation for decibel. Decibels are a method of expressing power or voltage ratios as
logarithms. When used for voltage ratios, as in TDR, the formula for decibels is db = 20-log:0(V;/V:) where
V:is the voltage of the incident pulse and V. is the voltage reflected back by the load. The dB vertical scale
on the CT100 refers to the amount of voltage gain the instrument applies to the signal before displaying it.
For example, when the instrument is amplifying the voltage by a factor of 100, this indicator would read:
vertical scale = 20-1og:10(100) = 40 dB.

DC

Direct current is unidirectional flow of electrical current. The term DC is also synonymous with constant; for
example, a perfect DC voltage source does not vary from a set value. Batteries are an example of a DC
voltage source.

Dielectric

A nonconducting substance or insulator. May also refer to the dielectric strength or relative permittivity of a
medium, which is a measure of the electrical energy stored by a medium when an electrical potential of a
given frequency is applied across it. Also see Insulation.

Digital

Refers to signals in which information is represented by variables that are discrete or discontinuous both in
time and in value. This is in contradiction to an analog signal, which is continuous both in time and value.

Domain

A mathematical term that refers to the set of values for which a function is defined. A time-domain
instrument such as a TDR performs its function by recording measurements as a function of time.

Impedance

The ratio of voltage to electrical current in a cable or circuit. Impedance is a frequency-dependent value
that is influenced both by resistive and reactive components. Impedance is expressed in terms of ohms but
should not be confused with resistance, which is a frequency independent quantity. Most cables have
impedances that vary little over the range of frequencies with which they are used. Impedance is described
by Z = R+j-Xwhere Ris resistance, jis the imaginary unit, and X'is the reactance at a given frequency. Also
see Reactance and Resistance.

96 CT100/ CT100S / CT100HF Operator's Manual



Glossary

Impedance Mismatch

A point in a cable or device under test in which the characteristic impedance changes, causing a partial
reflection of the energy in a test signal. See Reflection Coefficient.

Incident Pulse

The excitation pulse produced by a TDR and injected into the cable under test. The trace produced by the
TDR is the temporally-resolved reflections produced by the cable in response to the incident pulse. The
incident pulse in the CT100 is a step rise signal with a finite rise time. See Rise time.

Inductance
See Reactance.

Insulation

A coating on an electrical conductor that inhibits the flow of electricity. Insulation serves as both a means of
providing electrical safety and ensuring signal integrity.

Jitter

The uncertainty in measurement of time in a TDR, causing a particular voltage sample to be misregistered
slightly with respect to time. The main effect of timebase jitter is to cause apparent vertical noise in areas of
changing impedance. Areas of constant impedance, such as a flat segment of 50 Q cable, will show no
abnormality.

LCD

Liquid crystal display. The display used by this instrument is an active-matrix thin-film transistor LCD,
abbreviated TFT-LCD.

Millirho
See Reflection Coefficient.

Noise

Any undesirable electrical energy that impairs the ability of an electronic system to transmit or receive a
signal or make an accurate measurement. In TDR, noise is typically related to thermal and/or electrical
noise that interferes with the timebase or sampling circuitry and is usually random, although a nearby
strong electromagnetic radiator can cause non-random synchronous noise to be measured on unshielded
cable. In the case of random noise, averaging is an effective means of noise suppression.

Open Circuit

Describes a non-terminated cable or cable with a broken conductor that reflects all energy within the
incident pulse.

Precision

The variation in the value of a variable measured multiple times. Precision and accuracy are both important
factors in determining the reliability of a given measurement. Precision may also be used to describe the
number of digits or the unit of the least significant digit with which a particular quantity is expressed.
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Reactance

The imaginary component of electrical impedance. Reactance describes the opposition of a conductor to
the flow of alternating current. Impedance is described by Z = R+j-Xwhere Ris resistance, jis the
imaginary unit, and Xis the reactance at a given frequency. If X>0, the impedance is inductive, if X=0 then
the impedance is purely resistive, and if X<0 the impedance is capacitive.

Reflection Coefficient

In TDR, a coefficient describing the amplitude of a reflected signal produced by an impedance mismatch in
relation to the incident pulse. The reflection coefficient Gamma (I') is defined by the relation I' = (Z«-
Zo)/(Z++7Zo) where Z;is the impedance at time tand Z, is the characteristic impedance of the cable, and is
usually described in parts per thousand with units of rho (p) or millirho (mp). The coefficient p ranges from -
1 (short circuit) to +1 (open circuit). A reflection coefficient of zero indicates that there is no impedance
mismatch and no reflection of electrical energy.

Reflectometer

An instrument that measures reflections to determine the state of a system. The CT100 measures the
reflections of electrical energy.

Resistance

A conductor's opposition to electrical current. The reciprocal of resistance is conductance. Electrical
resistance can often be considered a constant that does not vary with respect to the voltage or current
applied to an object. When considering the impedance of a circuit element, resistance is also frequency
invariant. Most materials, including conductors, have some degree of electrical resistance. A special class
of materials called superconductors demonstrate zero electrical resistance.

Resolution

For a given parameter, the smallest increment that can be measured or displayed. In the setting of TDR,
resolution may refer to timebase resolution, which describes the smallest increment of time used by the
pulser-sampler system to produce signals and measure reflections, or spatial resolution, which is
dependent on the system rise time and determines the ability of the TDR to separate two closely spaced
cable faults.

Return Loss

A measure of the power reflected by impedance changes in a cable. Return loss is typically expressed as a
logarithm of the reflection coefficient, p: RL(dB) = -20-logis/p/Where RL is return loss. Cable faults such as
shorts and opens, which return all of the incident energy in the TDR signal, have return losses of 0 dB.

Rho (p)
See Reflection Coefficient.

Rise time

With respect to the incident pulse, the time required for the signal to change from 10% to 90%, or
alternatively 20% to 80%, of its final value. With respect to the sampling electronics, the time required for
the sampled value to change from 10% to 90% of the final value when a perfect step signal is applied. The
rise time of a pulser-sampler system is approximately equal to the root sum of squares of the pulse and
sampler rise times.
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RMS

An acronym for Root Mean Square, also abbreviated rms and known as the quadratic mean. This is a
useful statistical technique when considering time varying electrical quantities for which simple DC
definitions are not accurate, such as when determining the power dissipated by an AC source. The formula
for calculating an rms value of a given time-varying signal is:

xZ 4+ x5+ x5+ +x3
=
rms n

where x; represent discrete samples and n is the total number of samples.

Sampling Efficiency

The CT100 makes measurements through a process known as sequential sampling. In sequential
sampling, a succession of incident pulses followed by discrete samples progressively builds up a given
TDR trace. Sampling efficiency describes the ability of the sampling circuitry to adjust to rapid changes in
impedance within a TDR trace. Low sampling efficiency leads to a trace that appears too smooth.

Short Circuit

The condition in which the conductor in a cable or circuit comes into direct contact with the return path
conductor or earth ground. The electrical length of the cable measured by TDR is shortened to the point of
the short circuit.

Stability

The change in the accuracy of a measurement or piece of test equipment over a period of time such as the
calibration interval. Stability may also refer to changes in accuracy related to a specific environmental
influence such as vibration, temperature, or humidity.

TDR

Acronym for Time-Domain Reflectometer or Reflectometry. TDR instruments use a form of closed-circuit
radar to detect cable faults. A series of pulses are sent into a cable and reflected voltage is measured as a
function of time. If the velocity of propagation (Vp) is known, the length of a cable and the distance to cable
faults can be determined. TDR traces produced by step-rise TDRs like the CT100 describe the impedance
of a cable along its length and can accurately detect a wide range of cable faults that can impair high-
frequency analog/RF and digital communications systems.

Trace Averaging
See Noise.

Velocity of Propagation (Vp)

Velocity of propagation of an electrical signal within a cable as a fraction of ¢, the speed of light in a
vacuum. Coaxial cable usually has a Vp of between 0.6 and 0.9.
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